WSTRO & WSTROU
WaveStar™ Software for Oscilloscopes

WSTRM
WaveStar™ Software for Meters

User Manual

071-0220-02
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preface</td>
<td>vii</td>
</tr>
<tr>
<td>Contacting Tektronix</td>
<td>ix</td>
</tr>
<tr>
<td><strong>Getting Started</strong></td>
<td></td>
</tr>
<tr>
<td>Product Description</td>
<td>1–1</td>
</tr>
<tr>
<td>System Requirements</td>
<td>1–3</td>
</tr>
<tr>
<td>Supported Instruments</td>
<td>1–4</td>
</tr>
<tr>
<td>Installation and Uninstallation</td>
<td>1–5</td>
</tr>
<tr>
<td>Installing WSTRO or WSTROU</td>
<td>1–5</td>
</tr>
<tr>
<td>Installing WSTRM</td>
<td>1–9</td>
</tr>
<tr>
<td>Uninstallation</td>
<td>1–12</td>
</tr>
<tr>
<td>VISA</td>
<td>1–12</td>
</tr>
<tr>
<td><strong>Instrument Manager Service (IMS)</strong></td>
<td>2–1</td>
</tr>
<tr>
<td>Instrument Manager</td>
<td>2–1</td>
</tr>
<tr>
<td>Main Screen</td>
<td>2–1</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>2–2</td>
</tr>
<tr>
<td>Toolbar</td>
<td>2–4</td>
</tr>
<tr>
<td>Instrument List (Main Screen)</td>
<td>2–4</td>
</tr>
<tr>
<td>Add Instrument: RS-232 Connected</td>
<td>2–5</td>
</tr>
<tr>
<td>Add Instrument: GPIB connected</td>
<td>2–8</td>
</tr>
<tr>
<td>Add Instrument: AD007 GPIB-LAN Adapter Connected</td>
<td>2–10</td>
</tr>
<tr>
<td>Add Instrument: Infrared (IR) to RS-232 Connected</td>
<td>2–10</td>
</tr>
<tr>
<td>Remove an Instrument</td>
<td>2–11</td>
</tr>
<tr>
<td>Switching an Instrument Online or Offline</td>
<td>2–12</td>
</tr>
<tr>
<td>Shutting Down Service</td>
<td>2–12</td>
</tr>
<tr>
<td>Display and Print the IMS Activity Log</td>
<td>2–13</td>
</tr>
<tr>
<td>Display the Activity Log</td>
<td>2–13</td>
</tr>
<tr>
<td>Print the Activity Log</td>
<td>2–14</td>
</tr>
<tr>
<td>Set Instrument Permissions</td>
<td>2–14</td>
</tr>
</tbody>
</table>
# Operating Basics

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Operating basics</td>
<td>3-1</td>
</tr>
<tr>
<td>Main Screen Overview</td>
<td>3-1</td>
</tr>
<tr>
<td>Mouse Operation</td>
<td>3-2</td>
</tr>
<tr>
<td>Menu Bar</td>
<td>3-3</td>
</tr>
<tr>
<td>Toolbar</td>
<td>3-4</td>
</tr>
<tr>
<td>Explorer View</td>
<td>3-5</td>
</tr>
<tr>
<td>Data Sheet Pane</td>
<td>3-5</td>
</tr>
<tr>
<td>Copying and Linking Data</td>
<td>3-6</td>
</tr>
<tr>
<td>Copying</td>
<td>3-6</td>
</tr>
<tr>
<td>Linking</td>
<td>3-7</td>
</tr>
</tbody>
</table>

# Data Sheet Overview

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Sheet Overview</td>
<td>4-1</td>
</tr>
<tr>
<td>Data Sheet Pane</td>
<td>4-1</td>
</tr>
<tr>
<td>Common Sheet Overview</td>
<td>4-1</td>
</tr>
<tr>
<td>Creating, Opening, Saving, and Closing Data Sheets</td>
<td>4-1</td>
</tr>
<tr>
<td>Sizing, Tiling and Cascading Windows</td>
<td>4-2</td>
</tr>
<tr>
<td>Previewing and Printing</td>
<td>4-2</td>
</tr>
<tr>
<td>Copy and Linking</td>
<td>4-2</td>
</tr>
<tr>
<td>Copying into Microsoft Office Applications</td>
<td>4-3</td>
</tr>
<tr>
<td>Setting Properties</td>
<td>4-3</td>
</tr>
<tr>
<td>Shortcut Menu</td>
<td>4-3</td>
</tr>
<tr>
<td>Data Sheets and Compatible Data Types</td>
<td>4-4</td>
</tr>
<tr>
<td>Data Compatibility Between Data Sheets</td>
<td>4-4</td>
</tr>
<tr>
<td>YT Data Sheet</td>
<td>4-5</td>
</tr>
<tr>
<td>Waveform Operations</td>
<td>4-6</td>
</tr>
<tr>
<td>Zooming</td>
<td>4-6</td>
</tr>
<tr>
<td>Property Sheet</td>
<td>4-7</td>
</tr>
<tr>
<td>Cursors</td>
<td>4-7</td>
</tr>
<tr>
<td>Gates</td>
<td>4-7</td>
</tr>
<tr>
<td>Print Banner</td>
<td>4-7</td>
</tr>
<tr>
<td>XY Data Sheet</td>
<td>4-8</td>
</tr>
<tr>
<td>I/O Operations</td>
<td>4-8</td>
</tr>
<tr>
<td>Zooming</td>
<td>4-9</td>
</tr>
<tr>
<td>Property Sheet</td>
<td>4-10</td>
</tr>
<tr>
<td>Cursors</td>
<td>4-10</td>
</tr>
</tbody>
</table>
Table of Contents

Waveform Tabular Data Sheet ........................................ 4–11
   I/O Operations .................................................. 4–12
   Property Sheet ................................................ 4–12
   Gates ............................................................. 4–12
Datalog Tabular Data Sheet ........................................... 4–13
   I/O Operations .................................................. 4–13
   Copying vs. Linking ............................................ 4–14
   Starting and Stopping ......................................... 4–14
   Property Sheet ................................................ 4–14
StripChart Data Sheet .................................................. 4–15
   I/O Operations .................................................. 4–15
   Copying vs. Linking ............................................ 4–16
   Starting and Stopping ......................................... 4–16
   Property Sheet ................................................ 4–16
   Cursors .......................................................... 4–16
Datalog Measurements Data Sheet .................................... 4–17
   I/O Operations .................................................. 4–17
   Copying vs. Linking ............................................ 4–18
   Starting and Stopping ......................................... 4–18
   Property Sheet ................................................ 4–18
Notes Sheet .......................................................... 4–19
   Operations ...................................................... 4–20
   Supported Applications ....................................... 4–20
Waveform Measurement Data Sheet .................................. 4–21
   I/O Operations .................................................. 4–22
   Supported Applications ....................................... 4–22
   Property Sheet ................................................ 4–22
   Gates ............................................................. 4–22
Scalar-Viewer Data Sheet ............................................. 4–23
   I/O Operations .................................................. 4–23
   Supported Applications ....................................... 4–24
   Property Sheet ................................................ 4–24

Procedures

Procedures .......................................................... 5–1
Display Waveforms in the YT Data Sheet ......................... 5–1
   Tips ............................................................... 5–1
Display Two Waveforms in the XY Data Sheet .................... 5–2
   Tips ............................................................... 5–2
Dynamically Position Waveforms ................................... 5–3
Table of Contents

Zoom the YT, XY, or StripChart Data Sheets .................. 5–3
  To Zoom in Increments or by % ........................... 5–3
  To Zoom to Full Screen (YT and XY sheets only) .......... 5–3
  To Zoom On a Waveform Feature (YT and XY sheets only) 5–4
Change the YT or XY Waveform Display (Properties) ......... 5–4
  To Position a Waveform .................................. 5–4
  To Scale a Waveform ...................................... 5–4
  To Change Waveform Color ................................ 5–4
  To Lock the Trigger Points or Horizontal Scales of YT Waveforms .................................. 5–5
  To Display the Trigger Point on YT Waveforms ............ 5–5
  To Change the Graticule for XY and YT Data Sheets ....... 5–5
  To Change the Plot Style of XY Waveforms ................. 5–6
Measure Waveforms using the Waveform Measurement
  Data Sheet .................................................... 5–6
  Drag and drop waveform data from YT, XY, or Waveform
    Tabular sheet into Waveform Measurement sheet .......... 5–6
  Gate and drag and drop waveform data from YT sheet to
    Waveform Measurement Sheet ................................ 5–6
  Gate and drag/drop from Waveform Tabular Sheet .......... 5–7
Measure StripChart Plots using Cursors ....................... 5–7
Set Up Instrument (Data Source) .............................. 5–7
Copy the Instrument Screen ................................... 5–8
Copy the Screen Image to a PC Application .................... 5–9
Restore a Waveform to an Instrument .......................... 5–9
Install/Uninstall ............................................. 5–9
Connect to Instrument (GPIB & RS-232) ....................... 5–10
Saving and Restoring Data Sheets .............................. 5–11
  Save a Data Sheet .......................................... 5–11
  Restore a Data Sheet ........................................ 5–12
Saving and Restoring Workbooks ................................ 5–12
  Save a Workbook ............................................ 5–12
  Restore a Workbook ........................................ 5–13
Converting WSTR31 Notebook (*.nbk) Files ................... 5–14
  Differences in Converted Files ................................ 5–14
Saving and Printing Repetitive Snapshots of Data (“Babysitting”
  Mode) ......................................................... 5–15
Viewing Long Record Lengths .................................. 5–16
Exporting Data ................................................. 5–16
# WSTRM WaveStar for Meters and Virtual Instrument Software

## WSTRM WaveStar for Meters and Virtual Instrument Software

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specifications</td>
<td>6–1</td>
</tr>
<tr>
<td>Setup</td>
<td>6–1</td>
</tr>
<tr>
<td>Functional Check</td>
<td>6–3</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>6–3</td>
</tr>
<tr>
<td>Virtual Instrument Software Overview</td>
<td>6–7</td>
</tr>
<tr>
<td>DMM Instrument Image</td>
<td>6–8</td>
</tr>
<tr>
<td>Terminology</td>
<td>6–8</td>
</tr>
<tr>
<td>“Button Presses”</td>
<td>6–8</td>
</tr>
<tr>
<td>“Button Holds”</td>
<td>6–8</td>
</tr>
<tr>
<td>“Knob Turns”</td>
<td>6–9</td>
</tr>
<tr>
<td>Off Function</td>
<td>6–9</td>
</tr>
<tr>
<td>Menu Commands</td>
<td>6–10</td>
</tr>
<tr>
<td>File Menu</td>
<td>6–10</td>
</tr>
<tr>
<td>Edit Menu</td>
<td>6–10</td>
</tr>
<tr>
<td>View Menu</td>
<td>6–11</td>
</tr>
<tr>
<td>Settings Menu</td>
<td>6–12</td>
</tr>
<tr>
<td>Help Menu</td>
<td>6–13</td>
</tr>
<tr>
<td>Toolbar</td>
<td>6–13</td>
</tr>
<tr>
<td>Status Bar</td>
<td>6–14</td>
</tr>
</tbody>
</table>

## User Proxy Table Utility

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Proxy Table Utility</td>
<td>7–1</td>
</tr>
<tr>
<td>Proxy File Overview</td>
<td>7–1</td>
</tr>
<tr>
<td>Records</td>
<td>7–1</td>
</tr>
<tr>
<td>Initialization Commands</td>
<td>7–2</td>
</tr>
<tr>
<td>Main Screen</td>
<td>7–3</td>
</tr>
<tr>
<td>File Menu</td>
<td>7–4</td>
</tr>
<tr>
<td>Record Menu</td>
<td>7–5</td>
</tr>
<tr>
<td>Help Menu</td>
<td>7–6</td>
</tr>
<tr>
<td>Toolbar</td>
<td>7–6</td>
</tr>
<tr>
<td>Toolbar Buttons</td>
<td>7–6</td>
</tr>
<tr>
<td>Control Settings</td>
<td>7–6</td>
</tr>
<tr>
<td>Initialization Screen</td>
<td>7–8</td>
</tr>
<tr>
<td>Registry Screen</td>
<td>7–9</td>
</tr>
</tbody>
</table>
Table of Contents

RS-232

RS-232 ............................................................................. 8–1
Setting RS-232 Default Values ........................................... 8–1
RS-232 General Hints .......................................................... 8–4
RS-232 Cable Issues ............................................................. 8–5
RS-232 Cable Examples ....................................................... 8–6
  TDS 200 and TDS 300 Series Oscilloscope to PC
  (DB9 female to DB9 male) .................................................. 8–6
  Connecting Two Like Devices (DCE to DCE or DTE to DTE)
  Using Null Modem Cable .................................................. 8–7

GPIB

GPIB Overview ................................................................. 9–1

Index
Preface

This manual supports the following Windows™ 95 and NT 4.0 versions of WaveStar™ software products:

- WSTRO WaveStar Software for Oscilloscopes
- WSTROU Upgrade to WaveStar Software for Oscilloscopes from WaveStar 3.1 Software
- WSTRM WaveStar Software for Meters and Virtual Instrument Software

This manual is organized to cover all common information about WSTRO, WSTROU, and WSTRM, but also includes specific information for each product where applicable. The primary differences between WSTRO and WSTRM are the instruments and application sheets each supports and the addition of the Virtual Instrument software with WSTRM WaveStar Software for Meters.

This manual describes system requirements, installation, operating basics, data sheet overview and procedures, RS-232 and GPIB reference information, the WaveStar Instrument Manager Service, and the WaveStar User Table Proxy application. Refer to the online help for further information on the topics in this manual and for information on the user interface and advanced procedures.
The following table lists all of the documents included with your purchase and the purpose of each document.

**Documentation Set**

<table>
<thead>
<tr>
<th>Document</th>
<th>Purpose and Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Manual</td>
<td>Instructional manual that details the application, procedures, contacting Tektronix, and many other aspects of the product. Use this manual together with the online help.</td>
</tr>
<tr>
<td>Software License Agreement Envelope</td>
<td>Envelope that contains the CD-ROM and software key. The Tektronix Software License Agreement is printed on this envelope. Breaking the envelope seal means that you agree with the terms outlined in the agreement.</td>
</tr>
<tr>
<td>Software Key</td>
<td>Contains a 14-character software installation key that you are required to enter when you install this software. You will be asked to enter this key each time you install this software. You will not be able to install the software without it. Do not lose this document.</td>
</tr>
<tr>
<td>CD-ROM Jewel Case Insert</td>
<td>Contains product overview and installation information for each product on the CD-ROM.</td>
</tr>
<tr>
<td>Business Reply Card</td>
<td>Complete and return the business reply card to register your product.</td>
</tr>
</tbody>
</table>
## Contacting Tektronix

**Product Support**
For application-oriented questions about a Tektronix measurement product, call toll free in North America:
1-800-TEK-WIDE (1-800-835-9433 ext. 2400)
6:00 a.m. – 5:00 p.m. Pacific time

Or contact us by e-mail:
tm_app_supp@tektronix.com

For product support outside of North America, contact your local Tektronix distributor or sales office.

**Service Support**
Contact your local Tektronix distributor or sales office. Or visit our web site for a listing of worldwide service locations.

www.tektronix.com

**For other information**
In North America:
1-800-TEK-WIDE (1-800-835-9433)
An operator will direct your call.

**To write us**
Tektronix, Inc.
P.O. Box 1000
Wilsonville, OR 97070-1000
Product Description

WaveStar Software introduces a family of Windows 95 and NT 4.0 applications that bring information from either Tektronix TDS/THS oscilloscopes or TX-DMM digital multimeters to your PC desktop.

Capture
The WaveStar software provides the following features for setting up and capturing data:

- Setup communication to instruments through the WaveStar Connection Wizard.
- Extend communication to simple instruments, such as frequency generators, by defining the User-Specified Proxy (driver).
- Use the Explorer View to display these instruments and reveal their corresponding properties.
- Capture measurement waveforms and data easily without the need for programming.

Analyze
The WaveStar software provides the following features for data analysis:

- Drag and drop instrument data into an active data sheet and begin analysis at your PC.
- Analyze, annotate, and record information in a variety of data sheets.
- Capture and graphically view multiple waveforms on a graticule with the same scale and position as on the oscilloscope.
- Take measurements easily using tools such as measurement cursors, gates, and the zoom function.
Control

The WaveStar software provides the following control features:

- Step away from your desk and have WaveStar automatically capture data changes.
- Establish instrument links to automatically update new measurements.
- Control waveform information locally or over the network.

Document

The WaveStar software provides the following documentation and print features:

- Archive information in Microsoft Office or Microsoft Windows applications.
- Print banner function allows printing of long record lengths.
System Requirements

To install and run WaveStar software, you must have an IBM-compatible PC with the following installed:

- Microsoft Windows 95 or Windows NT 4.0
- 16 MB RAM or greater recommended
- CD-ROM drive, 4X or better
- Super VGA monitor or better
- 20 MB of disk space

If you are using WaveStar Software for Oscilloscopes, you will also need either a National Instruments IEEE-488.2 Interface Card or a PC-compatible serial communications COM port and an RS-232 cable.

If you are using WaveStar Software for Meters, you will also need a PC-compatible serial communications COM port and an infrared (IR)-to-RS-232 cable (included with the purchase of WSTRM).

When using the Tektronix AD007 GPIB-LAN Adapter, you can connect directly to the 10Base-T LAN (local area network) connector with a RJ-45 UTP cable (provided with your AD007 GPIB-LAN Adapter). For a complete list of the system requirements for the AD007 Adapter, refer to your AD007 GPIB-LAN Adapter User Manual.
Supported Instruments

The following table lists all of the oscilloscope families that WaveStar Software for Oscilloscopes currently supports.

Table 1–1: Supported Tektronix Oscilloscopes

<table>
<thead>
<tr>
<th>Series</th>
<th>Products</th>
</tr>
</thead>
<tbody>
<tr>
<td>TDS 200</td>
<td>TDS 210, TDS 220</td>
</tr>
<tr>
<td>TDS 300</td>
<td>TDS 310, TDS 320, TDS 340, TDS 340A, TDS 350, TDS 360, TDS 380</td>
</tr>
<tr>
<td>TDS 3000</td>
<td>TDS 3012, TDS 3014, TDS 3032, TDS 3034, TDS 3052, TDS 3054</td>
</tr>
<tr>
<td>TDS 400</td>
<td>TDS 410, TDS 410A, TDS 420, TDS 420A, TDS 430A, TDS 460, TDS 460A</td>
</tr>
<tr>
<td>TDS 800</td>
<td>TDS 820</td>
</tr>
<tr>
<td>THS 700</td>
<td>THS 710, THS 710A, THS 720, THS 720A, THS 720P, THS 730A</td>
</tr>
</tbody>
</table>

The following table lists all of the true RMS digital multimeter families that WaveStar Software for Meters currently supports.

Table 1–2: Supported Tektronix Digital Multimeters (DMMs)

<table>
<thead>
<tr>
<th>Series</th>
<th>Products</th>
</tr>
</thead>
<tbody>
<tr>
<td>TX-DMM</td>
<td>TX1, TX3</td>
</tr>
</tbody>
</table>
Installation and Uninstallation

This section outlines the software installation for all WaveStar software products.

Installing WSTRO or WSTROU

**NOTE.** To install the WSTRO software, you must have the 14-character code found in the Software Key document enclosed with the CD-ROM in the Software License Agreement envelope.

If you are installing the WSTROU (WaveStar Software Upgrade from WaveStar 3.1), you must have the serial number for your WSTR31 WaveStar Software. The serial number is on the WSTR31 floppy disks and on the label on the WSTR31 Software License Agreement Envelope.

Follow the steps below to install WaveStar Software for Oscilloscopes.

1. Insert the CD-ROM into the CD-ROM drive. Typically, the CD-ROM drive will run automatically. If it does not, run the Install.exe file located in the CD directory.

2. When the main installation screen appears, five sections are displayed which contain product information and support references. From left to right, these sections are:

   **WaveStar for Oscilloscopes.** Select this section to access the installer for WaveStar Software for Oscilloscopes, Upgrade from WaveStar 3.1 Software, Free 30-Day Demo, and Online Tutorial.

   **WaveStar for Meters.** Select this section to access the installer for WaveStar Software for Meters and the Online Tutorial.

   **AD007.** Select this section to access the installer for AD007 GPIB-LAN Adapter software.
Installation and Uninstallation

What's New. Select this section to find information on new Tektronix products or link directly to the Tektronix web site.

Contact. Select this section to find information on how to contact us with your questions, comments, suggestions, and more.

3. Click the mouse on the first section to choose WaveStar for Oscilloscopes.

4. The next screen will show the WaveStar for Oscilloscopes section highlighted in a new color and a menu bar at the top of the installer screen. Click Install.

5. The next screen offers you two choices in the left part of the screen: WaveStar Software for Oscilloscopes and Upgrade from WaveStar 3.1 Software. Click the appropriate choice for your installation.

6. The installation wizard appears next. Follow the instructions in the wizard, which will guide you through the process of installing the following WaveStar software components:
   ■ Microsoft DCOM
   ■ TekVisa
   ■ WaveStar for Oscilloscopes

DCOM

1. The installation wizard will tell you that Microsoft DCOM for Windows 95 Version 1.1 must be installed on your machine. DCOM is a software application that WaveStar Software requires to interact with Microsoft applications. Click Next.

2. Read the Microsoft DCOM for Windows 95 License Agreement. If you accept all of the terms in the license agreement, click Yes. If you do not accept the terms of the agreement, click No to end the setup process.
TekVisa

Next, you will be prompted to install TekVisa software, the Tektronix version of VISA. VISA is another communication application that is required for WaveStar software to talk to your instrument.

If you have another version of VISA already installed on your PC, you can choose to use the existing version, or you can replace that version with the provided TekVisa. See VISA on page 1–12 for information on TekVisa.

If you choose to install TekVisa, follow the steps below:

1. The Tektronix VISA installer starts. Click Next when you have read the preliminary information.

2. In the Choose Destination Folder dialog, select the directory location where you want Tektronix VISA installed. Click Next.

3. In the next Choose Destination Folder dialog, select the directory location where you want TekVisa VXI Plug and Play components installed. Click Next.

4. In the Setup Type dialog, select the type of installation you would like to perform and click Next.

   **Custom Setup Type.** Allows you to choose which components to install.

   **Full Setup Type.** Installs all VISA files (recommended).

5. The Start Copying Files dialog displays the directory location of where VISA and VXI Plug and Play files will be installed. If you want to change this information, use the Back button. If this information is correct, click Next.

6. When the installation is complete, the Setup Complete dialog appears. Click Finish to dismiss this dialog.
WaveStar for Oscilloscopes

1. The Welcome to WaveStar for Oscilloscopes dialog appears. Read the information in the dialog, and click Next.

2. Read the WaveStar Software for Oscilloscopes License Agreement. If you accept all of the terms in the license agreement, click Yes. If you do not accept the terms of the agreement, click No to end the setup process.

3. The User Information dialog appears next, prompting you to enter your name, company, and the software key code. If you are installing WSTROU, you will need the serial number from your WSTR31 floppy disks. (See the note on page 1–5.) Click Next when you are finished entering the information.

4. The Registration Confirmation dialog appears, asking you to confirm the registration information. If you need to change any information, click Back and re-enter the information. If the information is correct, click Yes.

5. The Choose Destination Location dialog appears, asking you to select a directory location for the WaveStar Software for Oscilloscopes files. Click Browse... to select a location other than the default. Click Next when you are finished.

6. After all the files have been installed, the Restart Windows dialog appears. It is recommended that you restart Windows to allow the proper operation of WaveStar Software for Oscilloscopes. Click OK.
Installing WSTRM

Follow the steps below to install WaveStar Software for Meters:

1. Insert the CD-ROM into the CD-ROM drive. Typically, the CD-ROM drive will run automatically. If it does not, run the Install.exe file located in the CD directory.

2. When the main installation screen appears, five sections are displayed which contain product information and support references. From left to right, these sections are:

   WaveStar for Oscilloscopes. Select this section to access the installer for WaveStar Software for Oscilloscopes, Upgrade from WaveStar 3.1 Software, Free 30-Day Demo, and Online Tutorial.

   WaveStar for Meters. Select this section to access the installer for WaveStar Software for Meters and the Online Tutorial.

   AD007. Select this section to access the installer for AD007 GPIB-LAN Adapter software.

   What’s New. Select this section to find information on new Tektronix products or link directly to the Tektronix web site.

   Contact. Select this section to find information on how to contact us with your questions, comments, suggestions, and more.

3. Click the mouse on the second section to choose WaveStar for Meters.

4. The next screen will show the WaveStar for Meters section highlighted in a new color and a menu bar at the top of the installer screen. Click Install.

5. In the next screen, click WaveStar Software for Meters.

6. The installation wizard appears next. Follow the instructions in the wizard, which will guide you through the process of installing the following WaveStar software components:

   - Microsoft DCOM
   - TekVisa
   - WaveStar for Meters
NOTE. Locate your 14-character software key code, which is found with the CD-ROM software license agreement. You will need it to install the software.

DCOM
1. The installation wizard will tell you that Microsoft DCOM for Windows 95 Version 1.1 must be installed on your machine. DCOM is a communication software that WaveStar Software needs to communicate with Microsoft applications. Click Next.

2. Read the Microsoft DCOM for Windows 95 License Agreement. If you accept all of the terms in the license agreement, click Yes. If you do not accept the terms of the agreement, click No to end the setup process.

TekVisa
Next, you will be prompted to install TekVisa software, the Tektronix version of VISA. VISA is another communication application that is required for WaveStar software to talk to your instrument.

If you have another version of VISA already installed on your PC, you can choose to use the existing version, or you can replace that version with the provided TekVisa. See VISA on page 1-12 for information on TekVisa.

If you choose to install TekVisa, follow the steps below:

1. The TekVisa installer starts. The first screen asks you to close all Windows programs and explains that this product is protected by copyright law and international treaties. Click Next when you have read this information.

2. In the Choose Destination Folder dialog, select the directory location where you want TekVisa installed. Click Next.

3. In the next Choose Destination Folder dialog, select the directory location where you want TekVisa VXI Plug and Play components installed. Click Next.
4. In the Setup Type dialog, select the type of installation you would like to perform and click Next:

**Custom Setup Type.** Allows you to choose which components to install.

**Full Setup Type.** Installs all VISA files (recommended).

5. The Start Copying Files dialog displays the directory location of where VISA and VXI Plug and Play files will be installed. If you want to change this information, use the Back button. If this information is correct, click Next.

6. When the installation is complete, the Setup Complete dialog appears. Click Finish to dismiss this dialog.

**WaveStar for Meters**

1. The Welcome to WaveStar for Meters dialog appears. Read the information in the dialog, and click Next.

2. Next, you will be asked to read the WaveStar Software for Meters License Agreement. If you accept all of the terms in the license agreement, click Yes. If you do not accept the terms of the agreement, click No to end the setup process.

3. The User Information dialog appears next, prompting you to enter your name, company, and the software key code. This unique code is the 14-character code found in the Software Key document enclosed with the CD-ROM in the Software License Agreement envelope. Click Next when you are finished entering all information.

4. The Registration Confirmation dialog appears asking you to confirm the registration information. If you need to change any information, click Back and re-enter the information. If the information is correct, click Yes.

5. The Choose Destination Location dialog appears, asking you to select a directory location for the WaveStar Software for Meters files. Click Browse... to select a location other than the default. Click Next when you are finished.
6. After all files have been installed, the Restart Windows dialog appears. It is recommended that you restart Windows to allow proper operation of WaveStar Software for Meters. Click OK.

Uninstallation

To uninstall the software, double click the Uninstall icon in the program group window. You can also use the Add/Remove feature in the Microsoft Windows Control Panel.

Both methods of uninstalling the software activate the Uninstall wizard, which will take you through the uninstall process.

VISA

TekVisa is the Tektronix version of VISA software. Typically, only one version of VISA runs on your computer, so you must choose between TekVisa and a VISA from another company.

Note the following information when choosing between TekVisa and another company’s VISA:

- The WaveStar software will work with a VISA from another company, provided the VISA software supports the interface types with which you are working.

  If you choose to use a VISA from another company and find it doesn’t work with the WaveStar software, you can install TekVisa later using the WaveStar installer.

- TekVisa does not support VXI Mainframe communication.

- The Tektronix AD007 GPIB–LAN Adapter requires VXI–11 interface support, which TekVisa provides.
Instrument Manager Service (IMS)
## Menu Bar

The menu bar contains five menus, each with submenu commands to control the application.

### Control

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Refresh Lists</td>
<td>Refreshes the instrument list and updates the connection status of all instruments.</td>
</tr>
<tr>
<td>Auto Shutdown</td>
<td>Configures the application to automatically shut down the Instrument Manager.</td>
</tr>
<tr>
<td>Connect Service</td>
<td>Configures the connection to the Instrument Manager.</td>
</tr>
<tr>
<td>Shutdown Service</td>
<td>Shuts down the Instrument Manager.</td>
</tr>
<tr>
<td>Exit User Interface</td>
<td>Exits the Instrument Manager.</td>
</tr>
</tbody>
</table>

### Edit

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Instrument</td>
<td>Adds an instrument to the Instrument Manager list.</td>
</tr>
<tr>
<td>Instrument Properties</td>
<td>Displays the connection properties of the selected instrument.</td>
</tr>
<tr>
<td>Delete Instrument</td>
<td>Deletes the selected instrument from the connection list.</td>
</tr>
<tr>
<td>Switch Instrument</td>
<td>Toggles the selected instrument connection between online and offline. You select the instrument in the IMS main window.</td>
</tr>
</tbody>
</table>

2-2 WaveStar Software User Manual
### View

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Turns the toolbar on and off.</td>
</tr>
<tr>
<td>Status Bar</td>
<td>Turns the status bar on and off.</td>
</tr>
<tr>
<td>Activity Log</td>
<td>Turns the activity log display on and off. The activity log lists the date, time, and results of communication between the PC and the instrument.</td>
</tr>
</tbody>
</table>

### Print

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activity Log</td>
<td>Prints the activity log.</td>
</tr>
</tbody>
</table>

### Help

<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Contents and Index</td>
<td>Displays the table of contents and index for the online help.</td>
</tr>
<tr>
<td>What's This</td>
<td>Displays What's This help on toolbar buttons and menu items. Select this menu item, and then click the button or menu item for which you want help.</td>
</tr>
<tr>
<td>InsMgr Overview</td>
<td>Displays the IMS Window Overview online help topic.</td>
</tr>
<tr>
<td>Technical Support</td>
<td>Shows information about contacting Tektronix for technical help.</td>
</tr>
<tr>
<td>About Instrument Manager</td>
<td>Shows the version information for the Instrument Manager.</td>
</tr>
</tbody>
</table>
Instrument Manager

ToolBar

The Instrument Manager toolbar contains buttons that operate as shortcuts to certain menu commands. Shown below is each button with a description of what the button controls.

1 Connect to a new instrument
2 View the instrument properties of the instrument selected from the list.
3 Delete the connection to the instrument selected from the list.
4 Toggles the selected instrument connection between online and offline. You select the instrument in the IMS main window.
5 Display the Instrument Manager activity log. The activity log lists communications, including communication errors, between your PC and your instrument.
6 Print the Instrument Manager activity log.
7 Access the online help.
8 Display What’s This help on toolbar buttons and menu items. Click this button, and then click the button or menu item for which you want help.

Instrument List (Main Screen)

The main screen of the Instrument Manager (see page 2-1) shows all the instruments available for connection and the following information:

- The alias you have assigned each instrument (if available)
- The connection (RS-232 or ASRL ports; GPIB ports)
- The permissions set for each connection
- Software and hardware status (running, not running, responding)
Add Instrument: RS-232 Connected

Once you have connected the new instrument to the PC using the appropriate RS-232 cable, follow the steps below to use the Instrument Manager Service (IMS) to set up communications between the instrument and the PC.

1. Power on the instrument.

2. Open the IMS application and click the Add toolbar button or select Edit | Add Instrument…

3. When Step 1 of the Instrument Connect wizard appears, select your instrument from the list, and click Next.

4. Step 2 lists all available RS-232 connections between the PC and your instrument. Note that ASRL is the same as an RS-232 Com port. Select the desired connection, and click Next.

---

**NOTE. If there are no listings, there are no RS-232 connections available. You should recheck your instrument-to-PC communication cable and make sure the instrument power is on. You should also make sure no other applications are using the RS-232 connection.**

---

5. Step 3 allows you to enter an alias for your instrument. This will be the name that appears in the IMS Alias list and in the WaveStar Software instrument explorer view. If you do not enter a name, the product family name is used by default. Enter an alias or leave the field blank, and click Next.

6. In Step 4, click Configure to reconfigure your connection settings. If you click Configure, a dialog appears showing the following settings (click Next to use the current RS-232 settings):

   **Baud.** The Baud rate is the speed of communication between your PC and instrument. The baud rate selected here must match the baud rate of the instrument to which you are connecting.
NOTE. You can connect TDS 3000 oscilloscopes at a maximum baud rate of 38,400; all other instruments are limited to a maximum baud rate of 9,600.

Stop bits. Stop bits are the number of bits sent with each character to identify the end of data for that character.

Data bits. Data bits are the number of bits sent for each character.

Flow control. Flow control is the type of handshaking used to guarantee accurate transmission of data from one device to another. This handshaking prevents buffers from overflowing in the receiving device.

Parity. Parity is the data bit added to each character to validate its correct transmission.

Terminator. Terminator is the character added to the end of each command or query to indicate the end of the command or query.

Timeout. Timeout is the length of time the application will try to communicate with the instrument before aborting the communication. The default setting is None, meaning the application will not time out during an attempt to communicate with the instrument.

Restore Factory Settings. Uses the RS-232 settings originally shipped with the selected instrument.

Restore Default Settings. Uses the predefined default settings for the selected instrument.

When you are finished configuring the settings, click Test New Settings. If the settings are accepted, a dialog appears telling you that the device proxy is running and the attached hardware is responding. Click OK.

7. The Step 4 dialog appears again. Click Next.
8. In Step 5, click Test to test your connection. If the connection is established, the following message appears:

"Device proxy (<Instrument Name>) is running and the attached hardware is responding."

If the connection is not established the following message appears:

"Device proxy (<Instrument Name>) is running but the attached hardware is not responding. Response string is: ()."

If you get the above message, check the following items:
- The cable connection between your instrument and PC
- You are connected to an available Com port on the PC
- The instrument power is on, and that you are using the correct cable. Refer to System Requirements on page 1–3 for a list of system and equipment requirements.

Use the Back button to check your settings and reconfigure the connection.

---

**NOTE.** If there are no listings, there are no RS-232 connections available. You should recheck your instrument-to-PC communication cable and make sure the instrument power is on. You should also make sure no other applications are using the RS-232 connection.

---

When you establish a good connection, click Next.

9. Click Finish in Step 6 to add this instrument and connection to the IMS list.
Add Instrument: GPIB connected

Once you have connected the new instrument to the PC using the appropriate GPIB cable, follow the steps below to use the Instrument Manager Service (IMS) to set up communications between the instrument and the PC.

1. Power on the instrument.

2. Check the GPIB address of your instrument. (The address is an instrument function; refer to the user manual for your instrument for information about how to check the GPIB address.)

3. Open the IMS application, and click the Add toolbar button or select Edit | Add Instrument...

4. When Step 1 of the Instrument Connect wizard appears, select your instrument from the list, and click Next.

5. Step 2 lists all available GPIB connections between your PC and your instrument. Select the desired connection, and click Next.

\[\text{NOTE. If there are no listings, there are no GPIB connections available. You should recheck your instrument-to-PC communication cable and make sure the instrument power is on. You should also make sure no other applications are using the GPIB connection.}\]

6. Step 3 allows you to enter an alias for your instrument. This will be the name that appears in the IMS Alias list and in the WaveStar Software instrument explorer view. If you do not enter a name, the product family name is used by default. Enter an alias or leave the field blank, and click Next.

7. In Step 4, click Configure to reconfigure your connection settings or Next to use the current GPIB settings. If you click Configure, a dialog appears showing the following settings:

   **Terminator.** Terminator is the character added to the end of each command or query to indicate the end of the command or query.

   **Timeout.** Timeout is the length of time the application will try to communicate with the instrument before aborting the commu-
nication. The default setting is None, meaning the application will not time out during an attempt to communicate with the instrument.

**Restore Factory Settings.** Restores the GPIB settings originally shipped with the selected instrument.

**Restore Default Settings.** Restores the predefined default settings for the selected instrument.

If you want to make your new selections the default settings for GPIB connections, click the Update GPIB settings button.

When you are finished configuring the settings, click Test New Settings. If the settings are accepted, a dialog appears telling you that the device proxy is running and the attached hardware is responding. Click OK.

8. The Step 4 dialog appears again. Click Next.

9. In Step 5, click Test to test your connection. If the connection is established, the following message appears:

   "Device proxy (<Instrument Name>) is running and the attached hardware is responding."

If the connection is not established, the following message appears:

   "Device proxy (<Instrument Name>) is running but the attached hardware is not responding. Response string is: ()."

If you get the above message, check the cable connection between your instrument and PC, make sure that the instrument power is on, and make sure that you are using the correct cable and interface card. Refer to System Requirements on page 1–3 for a list of system and equipment requirements. Use the Back button to check your settings and reconfigure the connection. When you establish a good connection, click Next.

10. Click Finish in Step 6 to add this instrument and connection to the IMS list.
Add Instrument: AD007 GPIB-LAN Adapter Connected

Refer to your AD007 GPIB-LAN Adapter User Manual, and configure the AD007 Adapter for your instrument. Once you have connected the new instrument to the AD007 Adapter and to your 10Base-T LAN using the appropriate RJ-45 UTP cable, follow the steps in Add Instrument: GPIB Connected on page 2–8 to use the Instrument Manager Service (IMS) to set up communications between the instrument and the PC.

Add Instrument: Infrared (IR) to RS-232 Connected

Once you have connected the new instrument to the PC using the appropriate cable (see WSTRM WaveStar Software for Meters and Virtual Instrument Software on page 6–1), follow the steps below to use the Instrument Manager Service (IMS) to set up communications between the instrument and the PC.

1. Power on your instrument.

2. Open the IMS application and click the Add button in the toolbar or select Edit | Add Instrument...

3. When Step 1 of the Instrument Connect wizard appears, select your instrument from the list and click Next.

4. Step 2 lists all the available RS-232 connections between your PC and your instrument. Select the desired connection, and click Next.

**NOTE.** If there are no listings, there are no RS-232 connections available. You should recheck your instrument-to-PC communication cable and make sure the instrument power is on. You should also make sure no other applications are using the RS-232 connection.

5. Step 3 allows you to enter an alias for your instrument. This will be the name that appears in the IMS Alias list and in the WaveStar Software instrument explorer view. If you do not enter a name, the product family name is used by default. Enter an alias or leave the field blank, and click Next.
6. In Step 4, click Next. The RS-232 communication settings are fixed for the TX-DMMs; changing the communication settings will not affect the settings used.

7. In Step 5, click Test to test your connection. If the connection is established, the following message appears:

   “Device proxy (<Instrument Name>) is running and the attached hardware is responding.”

   If the connection is not established the following message appears:

   “Device proxy (<Instrument Name>) is running but the attached hardware is not responding. Response string is: ().”

   If you get the above message, check the cable connection between your instrument and PC, make sure the instrument power is on, and make sure you are using the correct IR to RS-232 cable. Refer to System Requirements on page 1–3 for a list of system and equipment requirements. Use the Back button to check your settings and reconfigure the connection. When you establish a good connection, click Next.

8. Click Finish in Step 6 to add this instrument and connection to the IMS list.

Remove an Instrument

Follow the steps below to remove an instrument from the IMS application:

1. Open the IMS application.

2. In the Alias list, select the instrument you wish to remove.

3. Click the delete button in the tool bar or select Edit | Delete Instrument.
Switching an Instrument Online or Offline

You can have more than one instrument listed in the IMS with the same connection (see the Main Screen illustration on page 2–1). However, only one of these instruments can be online at any given time.

To switch an instrument online or offline, follow these steps:

1. Select the instrument you want to switch online or offline in the IMS main screen.

2. Select Switch Instrument from the Edit menu in the IMS application. One of the following dialogs will appear:

   - If the connection is currently in use with another instrument, a dialog will appear asking you to verify that you want to switch that instrument offline before switching the selected instrument online.

   - If the connection for the selected instrument is not in use, a dialog will appear asking you to verify that you want to switch the selected instrument online.

**NOTE.** You can also use the toolbar to switch an instrument online or offline. Refer to item 4 in the toolbar shown on page 2–4.

Shutting Down Service

The IMS application continues to occupy a COM port, even when the IMS application is closed. To release the COM port, select Shutdown Service from the Control menu before you close the IMS application. Select Auto Shutdown from the Control menu to shut down both the instrument server and the IMS application.
Display and Print the IMS Activity Log

The IMS Activity Log shows the time, date, and description of all communications between WaveStar Software and the instrument.

Display the Activity Log

Follow the steps below to display the IMS activity log:

1. Open the IMS application.

2. Click the View Log button in the IMS toolbar. When the activity log appears, you can select the following elements:
   - Local service activity. Logs communication between the instrument and WaveStar Software.
   - Internal program logic. Logs WaveStar Software operations.
   - Refresh button. Updates the activity log.

3. Click OK to dismiss the activity log.

Print the Activity Log

1. From the activity log, click Print; use the print dialog to print the log.

2. From the IMS window, click Print in the toolbar or select Print | Activity Log.
Set Instrument Permissions

1. Open the IMS application and select the instrument whose permissions you wish to change.

2. Click the Properties button in the toolbar or select Edit | Instrument Properties to display the Instrument Properties dialog box.

3. Click the following items to toggle the permissions on or off:
   - Read Only
   - Read/Write
   - Visible
   - Activity Logging

4. Click OK to apply your selections; press Cancel to discard them. Both buttons dismiss the Instrument Properties dialog box.
Operating Basics

This section of the manual outlines WaveStar Software features common to both WSTRO and WSTRM.

Main Screen Overview

This window displays instrument data in your PC environment. Here, WaveStar Software lets you interact with the Explorer View to control settings of the instrument, propagate the data that the instrument acquires into data sheets, and save and transfer the data into other Microsoft Windows applications. Once your instrument resources appear in WaveStar, you can:

- Set up instrument controls (for as many instruments as you have added and established connections to in the IMS).
- Copy or link instrument data such as waveforms and numerical strings from instrument channels to one or more data sheets.
- Drag and drop data from data sheets into supported Microsoft Office 97 applications such as Microsoft Word, Excel, Access, or Powerpoint.
The WaveStar window comprises a menu bar, a toolbar, and two panes: the Explorer View and the Data Sheet Pane. See the following illustration to see the different areas of the main screen.

**Mouse Operation**

You can use mouse operations to copy and link waveforms and instrument data from the Explorer View to data sheets, to copy data between data sheets, or to copy data from data sheets to Microsoft Office applications. See *Copying and Linking Data* on page 3–6.
Menu Bar

The menu bar contains commands that operate WaveStar. Note that some of these commands are not applicable to all data sheets.

File Menu. This menu allows you to perform the following operations:

- Create, open, close, and rename data sheets.
- Enable Autoversioning, which adds an automatic date and timestamp to data sheet or workbook files.
- Print (or print preview) data sheets or workbooks of data sheets.
- Print long waveforms in banner format. Refer to Print Banner on page 4-7.
- Exit the application.

Edit Menu. This menu allows you to perform the following operations:

- Cut, copy, and paste waveforms in and between data sheets.
- Undo and redo the last action.
- Remove the link(s) to the active data source.
- Create and edit data sheet annotations.
- Display and select clipboard formats.

View Menu. This menu allows you to perform the following operations:

- Turn the toolbar, Explorer view, and status bar display on and off.
- Turn the selected data sheet toolbar on and off.
- Refresh the data sheet or workbook data.
- Display the incoming and outgoing links of the data source selected in Explorer View.
- Display the property sheet of the selected data sheet.
- Center the display of data in the selected data sheet.
- Transfer a partial or full graticule display from XY or YT data sheets.
Window Menu. This menu allows you to perform the following operations:

- Arrange data sheet windows, or arrange their icons if windows are minimized.
- Select any data sheet displayed to make it active and bring it to the front of all the data sheets.

Help Menu. This menu allows you to perform the following operations:

- Accessing the Contents and Index for this help system.
- Activate the What's This? Help cursor.
- Activate the WaveStar Overview section of the online help.
- Display Tektronix Technical Support information.
- Display the WaveStar release version and copyright date.

Toolbar

The toolbar contains buttons that provide quick access to often used WaveStar operations.

1. Open a new data sheet.
2. Open existing workbook or data sheet.
3. Save selected data sheet.
4. Save entire workbook.
5. Cut selected object or text.
6. Copy selected object or text.
7. Paste selected object or text.
8. Print selected data sheet.
9. Print entire workbook.
10. Refresh data in selected data sheet.
11. Refresh data in workbook.
**Explorer View**

This pane exposes any instruments properly connected and appearing in the IMS list to control and data access by WaveStar. These instruments appear as tree directories in Explorer View, where you can, using operations similar to those used in Windows 95 Explorer, perform the operations listed in the next section, *Data Sheet Pane*.

**Data Sheet Pane**

This pane houses data sheets for displaying measured data in various forms. In the data sheet pane, you can do the following tasks:

- Create data sheets for displaying waveforms graphically, such as strip recordings, as tables, as statistics, or as measurements.
- Transfer data to and display it in the data sheets, using drag and drop operations similar to operations in Microsoft Windows.
- Document and analyze data, dragging and dropping it from data sheets to Microsoft Office applications.

The data sheet pane keeps data sheets in a workbook (.WK file extension). The workbook allows you to organize and save your data sheets (.SHT file extension) as a single collection. You can also save individual sheets; you can even import sheets saved earlier into workbooks or save only particular sheets out of workbooks.

**Ways to Use Data Sheets.** Because moving waveforms in and out of the WaveStar data pane and between its data sheets is as easy as dragging and dropping, you have many opportunities for using your data:

- Display waveforms from one channel or from many in the same data sheet or in individual data sheets.
- Display the same waveforms in different ways graphically, as tabular data, or as stripchart recordings, or all three ways at the same time.
- Compare waveforms in various views simultaneously, in one or more data sheets or in a single document (if you drag data from a data sheet into an MS Word document or Excel spreadsheet).
- Print a monochrome or color hardcopy of your data (depending on printer abilities).
Operating Basics

Copying and Linking Data

WaveStar Software enables you to either copy or link instrument data to a data sheet. You can also link data to a toolbar button.

Copying

Copying data results in a static snapshot of the data. The data does not update in the application as it updates on the instrument. (However, you can manually refresh the data sheet by selecting the Refresh Datasheet menu item in the View menu.)

To copy a waveform or a scalar value into a data sheet, do the following procedure:

1. Left click on the data object in the Explorer view, and hold down the mouse button. Refer to ① in the following illustration.

2. Drag the data object into the data sheet and release the mouse button. Refer to ② in the illustration.
Linking

Linking data results in dynamic data that updates in the application as it updates on the instrument. There are two methods of linking data to a data sheet or toolbar button.
Method 1.

1. Right click on the selected data object in the Explorer view, and hold down the mouse button. Refer to ➊ in the following illustration.

2. Drag the data object to target into the data sheet and release the mouse button. Refer to ➋.

3. Click Link in the shortcut menu that pops up. Refer to ➌.
Method 2.

1. Press and hold the Ctrl+Shift keys. Refer to ① in the following illustration.

2. Left click on the data object in the Explorer view, and hold down the mouse button. Refer to ②.

3. Drag the data object to the target. Release the mouse button and the Ctrl+Shift keys. Refer to ③.
Operating Basics
Data Sheet Overview

This section of the manual outlines each type of data sheet, how and when to use them, and explains behavior common to all data sheets.

Data Sheet Pane

The Data Sheet pane represents the WaveStar workbook; the data pane is an open WaveStar workbook that contains all data sheets appearing in the pane. You can save data sheets without saving the workbook, save the workbook, which saves all data sheets within it, or save both ways.

Dragging a new workbook from Windows Explorer into the data pane closes the currently open workbook and opens the workbook you dropped onto the data pane. You are prompted to save the currently open workbook file before it closes.

Dragging a data sheet to the data pane adds it to the open workbook.

Common Sheet Overview

All data sheets share some common characteristics.

Data sheets receive your data, waveforms, screen captures, and text, and then display it according to the type of data sheet receiving the data. Data sheets are used to:

- Receive data and update it if that data is linked to its source.
- Store data when saved as individual sheets or workbooks.
- Source and receive data from other data sheets.

Creating, Opening, Saving, and Closing Data Sheets

- To create a new sheet in the open workbook, select File | New and choose a sheet type.
To open an existing data sheet into a workbook, drag and drop it (*.sht file) from the Windows Explorer into the data sheet pane. (Or open it from the File menu or toolbar.)

- To save a data sheet, click on its title bar in the data sheet pane, and then click the button in the toolbar. You can also save a data sheet by selecting File | Save Data Sheet.
- To close a data sheet, select File | Close Datasheet.

**Sizing, Tiling and Cascading Windows**

- To scroll data or size the data sheet, use normal windows procedures.
- To auto arrange or otherwise manipulate windows or icons, select the appropriate menu items in the WaveStar Window menu.

**Previewing and Printing**

- To set up and print data sheets, select the data sheet, and then select File | Print. You can also print all the data sheets that are open by selecting File | Print Workbook, and then selecting the data sheets you want printed in the Print Workbook dialog.

- To print the full record length of all waveforms in the YT data sheet, select the data sheet and choose Print Banner... in the WaveStar File menu. The Print Banner option is useful when your YT data sheet contains waveforms that are longer than the width of the graticule.

**Copy and Linking**

You can either copy (no updating) or link (periodically updates data) waveforms and scalar data into a data sheet.

- To copy a waveform or a scalar value into a data sheet, left click the data object in the Explorer view and drag it into the data sheet.
- To link, right click the data object and drag it to the target. When you release it, choose Link from the shortcut menu that pops up. For more detailed information, refer to *Copying and Linking Data* on page 3–6.
Copying into Microsoft Office Applications

You can copy (but not link) a waveform from a data sheet into an Microsoft Word document or Excel spreadsheet by left clicking the data object and dragging it into an Microsoft Office application.

To copy numerical data (text) to the Windows clipboard, select simple text or rich text in the Clipboard Formats dialog (in the Edit menu). If you would rather copy a bitmapped image of the data sheet, uncheck both simple and rich text in that dialog. Then click any measurement value and drag it to the Windows application to which you want to copy the image.

Setting Properties

Property page settings determine the appearance and function of each data sheet in the open workbook.

- To access the Property page for a data sheet, click in its title bar to select it, and then choose Properties from the View menu.

  You can also access Property Pages by right clicking in an active data sheet and selecting properties from the displayed submenu. All right-click menus for data sheets contain a Properties option, which provides access to individual property pages.

- To navigate to individual tabbed sheets (if the property page has multiple tabs), left click on the tab to bring it into the foreground as needed. Click OK when you are finished entering property settings to save the property settings, and close the dialog.

Shortcut Menu

Right click in the data sheet data area to pop up a menu that contains the entries for performing the following tasks:

- Save, close, or print the data sheet.

- Display the property sheet for this data sheet.

- Show the data source links to the selected data sheet.

- Access the online help for the selected data sheet.
Data Sheets and Compatible Data Types

WaveStar data sheets can handle two types of data:

- Waveforms, such as those displayed from an oscilloscope channel
- Scalar values, such as a volts per division, a waveform measurement, or meter readout value

Each sheet can accept one or more data types and will handle data differently depending on the type.

Linked data values continue to be updated with new data points from the source; static plots and tables (copied data) do not update.

Data Compatibility Between Data Sheets

Waveform data sheets can only accept copies (or links) from other waveform data sheets.

Data sheets that handle scalar values can only move (source) data to another data sheet that displays scalar values. Note that the scalar targets can accept data from the Waveform Measurement data sheet as well.

If you drag a waveform plot from the XY sheet to another sheet, the plot is decomposed into its X and Y waveform components and handled as two individual waveforms. If you click and drag the X or Y component box for the XY waveform, the associated component is copied.

If you drop data onto the XY sheet, the first two available waveforms are copied to the X and Y components. If you drop data onto a specific component box, the data is copied to that specific box.

The Waveform Measurement sheet can act as a waveform object (if you drag a complete column of data) or a scalar value (if you drag a single cell of data).
YT Data Sheet

The YT sheet allows you to capture and graphically view multiple waveforms on a graticule with the same scale and position as on the oscilloscope.

The YT sheet displays one or more waveforms as a graphical view. This sheet displays amplitude on the Y-axis and the sampling index (for example, time) on the X-axis. The YT sheet displays waveforms and a graticule at the same scale and position as they appear on the oscilloscope screen. The number of waveforms that can be displayed is limited only by available memory. Some of the features of this sheet include cursor measurements, gates, zoom function, and annotation.
**Waveform Operations**

You use drag and drop mouse operations to copy and link waveforms from the Explorer View to the YT data sheet, dropping the waveform anywhere in the graticule area.

You use drag and drop mouse operations to copy data from data sheets to other Microsoft Windows applications. When copying a YT graticule to another application, you have the choice of copying the graticule as it is displayed on screen (which may be a partial graticule) or copying the entire graticule.

Copying a partial graticule is useful if, for example, you want to zoom in the display and copy a particular area of a waveform. To always copy the entire graticule whether or not it is fully displayed, select the View menu and check the Transfer Full Graticule menu item.

To restore the waveform to a specific channel, expand the instrument data channels in Explorer View, and drag the waveform to the desired channel. You cannot undo this operation. See *Copying and Linking Data* on page 3–6 and *Copy and Linking* on page 4–2.

**Zooming**

The YT tool bar contains controls for zooming the entire graticule and its waveforms within the YT data sheet window.

![Zoom Controls](image)

The numerical field tells you the percentage of normal view in which the sheet is displayed. The first and second toolbar buttons are for increasing and decreasing the zoom percentage, respectively. The third toolbar button is for zooming the sheet to allow the entire graticule to be viewed. The fourth toolbar button allows you select a specific sheet area to enlarge. Select the Drag Zoom button. Then, in the graticule click and drag the mouse to draw a box around the part of the waveform you want to enlarge.
Property Sheet

The property sheet can set various display and measurement characteristics. You can set these properties from the YT Properties page (see Setting Properties on page 4–3). Refer to the online help for detailed information on the YT sheet property dialog and each control field in the dialog.

Cursors

Cursors are used to measure the waveform plot. You can put cursors on the selected sheet using the Cursor tab on the Property Page. Cursor readout values indicate the vertical or horizontal value at the cursor location. Vertical cursor position values appear as dX and X. Horizontal cursor position values appear as dY and Y.

Gates

Gates define the range over which measurements are computed when waveform data is moved from this sheet to a waveform measurement sheet. Turn on gates by choosing vertical cursors in the Cursor Property dialog and checking the Gate with Vertical Bar Cursors checkbox; then, set gate location by using the mouse to move the cursors.

Print Banner

To print the full record length of all waveforms in the YT data sheet, select the data sheet and choose Print Banner... in the WaveStar File menu. The Print Banner option is useful when your YT data sheet contains waveforms that are longer than the width of the graticule.
XY Data Sheet

The XY sheet displays waveforms in pairs as XY plots, with one waveform plotted on the X (horizontal) axis against the other on the Y (vertical) axis. The XY plot uses the same scale and position as the oscilloscope channels from which the XY components are obtained.

The XY sheet presents the XY plot as a pair of X and Y component boxes, which appear along the bottom of the graticule.

I/O Operations

Using the mouse to copy and link waveforms from the Explorer View to the XY data sheet, you can do the following I/O operations:

- Drag individual channel waveforms from the Explorer View and other data sheets to the individual X or Y component boxes (located just below the bottom graticule) that comprise each XY waveform.
Drag two of the waveforms an instrument contains to a XY sheet at once by dragging the instrument icon from the Explorer View and dropping the icon anywhere on the XY graticule. The first waveform in the hierarchy is plotted as X, the second as Y.

Drag from each X and Y component individually, to the Explorer View or another data sheet. To restore the waveform as a saved waveform for an instrument, display the instrument reference memories, and drag the waveform to the memory that is to store the waveform. You cannot undo this operation.

Drag and drop X and Y components individually or as an XY waveform into Microsoft Office applications.

When copying an XY graticule to another application, you have the choice of copying the graticule as it is displayed on screen (which may be a partial graticule display) or copying the entire graticule.

Copying a partial graticule is useful if, for example, you want to zoom in the display and copy a particular area of a waveform. To always copy the entire graticule whether or not it is fully displayed, select the View menu and check the Transfer Full Graticule menu item.

You can drop data onto the XY sheet, or to a specific waveform component box. If you drop data onto the XY sheet, the first two waveforms are used as the X and Y components. If you drop data onto a specific waveform component box, the data is copied to the specific box, possibly overwriting what was there previously. The XY plot is drawn when both the X and Y component boxes are filled in. See Copying and Linking Data on page 3–6 and Copy and Linking on page 4–2.

**Zooming**

The XY tool bar contains controls for zooming the entire graticule and its waveforms within the XY data sheet window.
The numerical field tells you the percentage of normal view the sheet is displayed in. The first and second toolbar buttons are for increasing and decreasing the zoom percentage, respectively. The third toolbar button is for zooming the sheet to allow the entire graticule to be viewed. The fourth toolbar button allows you select a specific sheet area to enlarge. Select the Drag Zoom button. Then, in the graticule click and drag the mouse to draw a box around the part of the waveform you want to enlarge.

**Property Sheet**

The property sheet can set various display and measurement characteristics. You can set these properties from the XY Properties page (see *Setting Properties* on page 4–3). Refer to the online help for detailed information on the XY sheet property dialog and each control field in the dialog.

**Cursors**

Cursors are used to measure the waveform plot. You can put cursors on the selected sheet using the Cursor tab on the Property Page. Cursor readout values indicate the vertical or horizontal value at the cursor location. Vertical cursor position values appear as dX and X. Horizontal cursor position values appear as dY and Y.
Waveform Tabular Data Sheet

A Waveform Tabular Sheet creates a table of values for each waveform that you copy or link to it. It periodically updates the values if you link them from the data source.

The Waveform Tabular Sheet shows the waveform as sequential values in a table column with each value accompanied by a time value. The time value is the time of the waveform sample relative to the waveform record trigger.

You can modify the waveform by editing the table cells, but you cannot change the length of the waveform by adding or deleting cells, nor can you change the units.
I/O Operations

You use drag and drop mouse operations to copy and link waveforms, such as channel waveforms from a TDS oscilloscope, from the Explorer View to the waveform-tabular data sheet, dropping the waveform anywhere in the data sheet table. Subsequent copies or links to the same data sheet create separate table charts (two waveforms cannot be recorded in the same table). You must drag a complete waveform (a column) to an XY or YT data sheet (or another Waveform Tabular data sheet).

Use drag and drop mouse operations to copy a table from a data sheet to a Microsoft Office application. Two columns of scalar values are transferred with measurement values appearing along recording times.

You can transfer the tabular data as a screen image by dragging the entire sheet to Microsoft Word. You can also drag selected variables to Excel or another Datalog Tabular sheet. See Copying and Linking Data on page 3–6 and Copy and Linking on page 4–2.

Property Sheet

Use this property sheet to control table layout characteristics (see Setting Properties on page 4–3). Refer to the online help for detailed information on the waveform tabular property dialog and each control field in the dialog.

Gates

Gates define the range over which measurements are computed when waveform data is moved from this sheet to a Waveform Measurement sheet. Set gate location by moving the gate icon to the desired location. Gate location is represented by highlighting the corresponding row of data.
Datalog Tabular Data Sheet

A Datalog Tabular Sheet periodically captures and enters the value of a single scalar data item, such as a meter readout or waveform measurement, in a table.

The table displays each data point one row at a time as an entry under the Value column. Time and Units columns record the time stamp and the units for each data value at fixed time intervals.

As each new value is recorded, any values outside the alarm limits are drawn in the over- or under-limit colors.

I/O Operations

You use drag and drop mouse operations to copy and link scalar values, such as a TDS oscilloscope automatic measurement, from the Explorer View to the datalogging-tabular data sheet, dropping the measurement anywhere in the data sheet table. Subsequent copies or links to the same data sheet create separate charts (two variables cannot be recorded in the same table).
You use drag and drop mouse operations to copy a data table from data sheets to Microsoft Word or Excel. Two columns of scalar values are transferred with measurement values appearing along recording times.

You can transfer the tabular data as a screen image by dragging the entire sheet to Microsoft Word. You can also drag selected variables to Excel or another Datalog Tabular sheet. See Copying and Linking Data on page 3–6 and Copy and Linking on page 4–2.

Copying vs. Linking

You should link your data (right click and drag it), rather than copying because copying creates values that do not update. The Datalog Tabular data sheet monitors data, recording its variations.

When you link a scalar value to a tabular sheet, the source sends an update whenever data changes, possibly at irregular intervals. The data sheet collects all the data, but only enters the new row containing a data point at the data-logging rate specified in the data-sheet property sheet. If no new data has been received during a data-logging interval, the data sheet enters the last value logged.

Starting and Stopping

The recording can be started with one of three selections: Automatic, Manual, and Time. The default is Automatic, with a recording time of one second. Recording can be stopped with one of three selections: Manual, Time, Duration. The default is Manual. You can set the recording methods from the Recording tab of the property page (see Setting Properties on page 4–3). The minimum rate you can set is 1 second.

Click this button to start recording.

Click this button to stop recording.

Property Sheet

The property sheet can set table layout, how recording occurs (start, stops), and alarm limits on the recorded data. You can set these properties from the Datalog Tabular property pages (see Setting Properties on page 4–3). Refer to the online help for detailed information on the datalogging tabular sheet property dialog and each control field in the dialog.
StripChart Data Sheet

A StripChart sheet periodically plots the value of a single scalar data item, such as a meter readout or a waveform measurement on a graticule. You cannot drag waveforms from a YT or XY sheet to a StripChart sheet.

The data is displayed one point at a time at fixed time intervals on a grid-type graticule. You can choose to have points on the graph connected by lines or displayed as levels (dots).

I/O Operations

You use drag and drop mouse operations to copy and link scalar values, such as a TDS oscilloscope automatic measurement, from the Explorer View to the StripChart data sheet, dropping the measurement anywhere in the graticule area. Subsequent copies to the same StripChart sheet create separate strip-charts (two measurements cannot be plotted on the same StripChart).

You use drag and drop mouse operations to copy a StripChart recording to data sheets to Microsoft Word or Excel. Two columns of scalar values are transferred with measurement values appearing along recording times. See Copying and Linking Data on page 3–6 and Copy and Linking on page 4–2.
Copying vs. Linking

Strip charts monitor data, recording its variations. Because of this, you should link your data rather than copying it, since copying creates a value that does not update. To link data, right-click on the data and hold down the mouse button; drag the data to the Strip chart sheet. Then select Link from the shortcut menu that pops up.

When you link a scalar value to a Strip chart sheet, the data source sends updated data whenever data changes, possibly at irregular intervals. The data sheet collects all the data, but only plots a data point at the plot rate specified in the strip-chart property sheet. If no new data has been received during a data-logging interval, the data sheet plots the last value logged.

Starting and Stopping

The recording can be started with one of three selections: Automatic, Manual, and Time. The default is Automatic, with a recording time of one second. Recording can be stopped with one of three selections: Manual, Time, or Duration. The default is Manual. You can set the recording methods from the Recording tab of the property page (see Setting Properties on page 4–3). The minimum rate you can set in the properties page is 1 second.

Property Sheet

The property sheet can set a variety of display characteristics, turn on various types of measurement cursors, and more. You can set these properties from the Strip Chart properties pages (see Setting Properties on page 4–3). Refer to the online help for detailed information on the StripChart property dialog and each control field in the dialog.

Cursors

Cursors are used to measure the waveform plot. You can put cursors on the strip-chart sheet using the Cursor Property Page. Cursor readout values indicate the vertical or horizontal value at the cursor location. Vertical cursor position values appear as dX and X. Horizontal cursor position values appear as dY and Y.

Vertical and horizontal are the only permitted cursor types on the Stripchart sheet.
Datalog Measurements Data Sheet

A Datalog Measurement sheet periodically captures and evaluates the value of a single scalar data item, such as a meter reading or waveform measurement. After evaluation, this data sheet updates its table with these elements:

- Current Value: The current time, value, and units of the variable.
- Maximum, Minimum: The maximum and minimum values, and the time at which each occurred.
- Average, Max-Min, Standard Deviation: Statistical values calculated on the entire data stream. Time stamping is not applicable.

The Datalog Measurement sheet displays each new data value as the current value and uses each new value to continually recompute these measurements. It does not keep previous data values (compare with the Datalog Tabular data sheet described on page 4–13).

i/O Operations

You use drag and drop mouse operations to copy and link scalar values, such as a TDS oscilloscope automatic measurement, from the Explorer View to the data datalogging measurement data sheet, dropping the measurement anywhere in the data sheet table.
Subsequent copies or links to the same data sheet create separate charts (two variables cannot be recorded in the same table).

You use drag and drop mouse operations to copy a data table from data sheets to Microsoft Word or Excel. Two columns of scalar values are transferred with measurement values appearing along recording times.

You can get a screen image by dragging the entire sheet to Microsoft Word. You can drag selected variables to Excel or another datalog measurement sheet. See Copying and Linking Data on page 3–6 and Copy and Linking on page 4–2.

**Copying vs. Linking**

You should link your data (right click and drag it), rather than copying because copying creates a value that doesn’t update. This data sheet monitors data, recording its variations.

Whenever the linked data changes, Explorer View notifies the sheet, although measurements are not computed immediately. The sheet stores the data until its display interval has elapsed, at which time the new value is used to recompute the measurements. If no new data has been received during the interval, the same value is used.

**Starting and Stopping**

The recording can be started with one of three selections: Automatic, Manual, and Time. The default is Automatic, with a recording time of one second. Recording can be stopped with one of three selections: Manual, Time, or Duration. The default is Manual. You can set the recording methods from the Recording tab of the property page. The minimum rate you can set in the properties page is 1 second.

**Property Sheet**

The property sheet can set table layout and how the recording occurs (start and stops). See Setting Properties on page 4–3. Refer to the online help for detailed information on the datalog measurement property dialog and each control field in the dialog.
Notes Sheet

The Notes data sheet lets you enter and save textual notes and graphical images that you want to record for the open workbook file. Specifically, you can do the following:

- Type textual notes.
- Copy and paste notes and bitmapped images between the clipboard and the notes sheet.
- Drag and drop instrument screens from the Explorer View to the notes sheet.
- Drag and drop (or cut, copy, and paste, depending on application) between the notes sheet and other Windows applications.

Measurement taken at Grass Valley plant
June 14, 1998, 10:16 a.m.
T & M Device 6A
E. Brimmer
Data Sheet Overview

Operations

You can perform the following operations in the notes sheet:

- Right click in the data sheet area to pop up a menu that lets you save, close, or print your data sheet or access online help about the data sheet.

- Format the text font, color, and alignment using the toolbar buttons. (If the toolbar buttons for the Notes Sheet are not displayed, go to the View menu for the WaveStar application and check Datasheet Toolbar.)

- Use the Save, Cut, Copy, Paste, and Print toolbar buttons and WaveStar menu commands to perform these tasks.

Supported Applications

Use your mouse to drag and drop text or bitmapped images between the notes sheet and Windows applications such as Microsoft Office applications and Windows Notepad.

When copying an XY or YT graticule to another application, you have the choice of copying the graticule as it is displayed on screen (which may be a partial graticule) or copying the entire graticule.

Copying a partial graticule is useful if, for example, you want to zoom in the display and copy a particular area of a waveform. To always copy the entire graticule whether or not it is fully displayed, select the View menu and check the Transfer Full Graticule menu item.
Waveform Measurement Data Sheet

The waveform measurement data sheet displays a table of standard waveform measurements. When you drag a waveform to this sheet, the application automatically calculates and displays the measurement values as shown below in the following figure.

Each waveform is presented as a column of measurements. Each time a new waveform is dropped onto this sheet, a new column of measurements is created immediately to the right of any existing columns.
I/O Operations

You use drag and drop mouse operations to copy and link waveforms (not scalar data) from the Explorer View to the waveform measurement data sheet.

You use the same operations to copy and link waveforms from this data sheet to other data sheets. You can also copy or link a single measurement from this data sheet to any other sheet that accepts scalar values. See Copying and Linking Data on page 3–6 and Copy and Linking on page 4–2.

Supported Applications

You use drag and drop mouse operations to copy measurements from this sheet to Microsoft Word or Excel. Specifically, you can do the following:

- Click a single measurement and drag it to Microsoft Word or Excel.
- Shift click to select more than one measurement for dragging as a group.
- Click in the title bar to select all of the measurements; shift click to select additional columns as desired. After selecting the last column, hold shift to drag all the columns to Word or Excel.

Property Sheet

Use this property sheet to control table layout characteristics and the measurement method (see Setting Properties on page 4–3). Refer to the online help for detailed information on the waveform measurement property dialog and each control field in the dialog.

Gates

You can use gates in YT and waveform tabular data sheets to define a segment of a waveform for copying or linking to the waveform measurement sheet. Such operations let you determine the part of the waveform measured by using the gates to isolate a portion of the waveform.
Scalar-Viewer Data Sheet

If you want to view one or more scalar values, copy or link them from the Explorer view to this data sheet. Such values display with time stamp, data value, and data units.

When you want to compile a custom view of measurements (or any set of scalar data) or download your TX-DMM stored memory (WSTRM), use the Scalar-Viewer. For example, if you want to continuously monitor measurements taken by different instruments, connect those instruments to WaveStar and drag those measurements from the Explorer View to a common Scalar-Viewer sheet. Or drag scalars from other data sheets to the Scalar-Viewer sheet.

I/O Operations

You use drag-and-drop mouse operations to copy and link scalar values, such as a TDS oscilloscope automatic measurement, from the WaveStar Explorer View to the Scalar-Viewer sheet, dropping the waveform anywhere in the data sheet table. Subsequent copies to the same Scalar-Viewer sheet create separate rows in its table.

Copy your data if you want to just get the current value; link it (right click and drag it), if you want the data to update.

You use the same operations to copy and link scalar values from Scalar-Viewer data sheets to other data sheets that accept scalar values. See Copying and Linking Data on page 3–6 and Copy and Linking on page 4–2.
**Supported Applications**

You use drag-and-drop mouse operations to copy a Scalar-Viewer table to data sheets or to Microsoft Word or Excel. Scalar values are transferred with measurement values appearing alongside recording times.

To copy a bitmapped image of the data sheet instead of numerical values, uncheck both simple and rich text in Clipboard Formats dialog box, accessed from the Edit menu, before copying.

**Property Sheet**

The property sheet can set various attributes of the table layout. You can set these attributes from the Scalar-Viewer properties page (see *Setting Properties* on page 4–3). Refer to the online help for a detailed description of the Scalar-Viewer data sheet property page and each entry field in the property sheet.
Procedures

This section outlines procedures for both WSTRO and WSTRM WaveStar Software.

Display Waveforms in the YT Data Sheet

Follow the steps below to display waveforms in the YT view.

1. In the Explorer View, click on the Data branch under the instrument that will source the waveform to display the data resources under it.

2. Double click on the Waveforms resource (or single click its +) to display the waveform sources below it.

3. To copy, left click and drag the waveform resource (Channel, Math, or Ref) to the YT data. Release the waveform in the data sheet graticule area to drop the waveform on the data sheet.

4. To link rather than copy, right click and drag the waveform to the YT data sheet. Release the mouse button, and select Link in the shortcut menu that pops up.

5. Repeat this procedure to copy or link additional waveforms to the data sheet as desired.

Tips

- Drag the channel indicator (located left of the graticule) up and down to vertically position the waveform. (You can also use the keyboard arrows (↑ and ↓) to position the waveform.)

- Drag the waveform record view (located above the graticule) to horizontally position the waveform in the graticule. (You can also use the keyboard arrows (← and →) to position the waveform.)

- To remove the waveform just dropped into the window, immediately select Undo Drop Waveforms in the Edit menu (the undo function is not available for extremely large records).
Display Two Waveforms in the XY Data Sheet

Follow the steps below to display waveforms in the XY view.

1. In the Explorer View tree, click on the Data branch under the instrument that will source one of the waveforms to display the Data resources under that Data branch.

2. Double click on the Waveform resource (or single click its +) to display the waveform sources below it.

3. To copy, left click and drag the waveform source (Channel, Math, or Ref) onto the X tab. Release the waveform while holding it over the X tab.

   To link rather than copy, right click and drag the waveform to the X tab. Release the mouse button, and select Link in the shortcut menu that pops up.

4. Repeat this procedure to display a Y source and copy or link it to the Y tab. Be sure to release over the Y tab, not the X tab.

---

NOTE. *The X and Y tabs always appear below the graticule. If they are not visible, expand or scroll the data sheet window.*

---

Tips

- If you drag and drop a data source icon that contains more than two waveforms onto the XY graticule, the first waveform in the list will be used for the X tab and the second available waveform will be used for the Y tab.

- Drag the indicator to the left of the graticule up and down (or use the keyboard ↑ and ↓ arrows) to vertically position the XY plot to position the waveform.

- Drag the indicator above the graticule to horizontally position the XY plot.

- To swap the X waveform with the Y, select Swap XY from the Edit menu.
To remove a waveform just dropped into the window, immediately select Undo Drop Waveforms in the Edit menu.

**Dynamically Position Waveforms**

1. In an XY or YT data sheet, locate the channel indicator of the waveform to be positioned. YT sheets have channel indicators on the left border of the graticule; XY sheets have a Y channel indicator on the left border and an X channel indicator on the top border of the graticule.

2. Click and drag any of the channel indicators to adjust positions as desired up and down (and left and right for XY data sheets).

3. YT waveforms have a waveform record view above the graticule. Click and drag the record view to position the selected waveform horizontally in the graticule.

**Zoom the YT, XY, or StripChart Data Sheets**

In YT, XY, or StripChart data sheets, use the following methods for zooming in or out.

**To Zoom in Increments or by %**

Click the first toolbar button from the left to zoom in; click the second toolbar button to zoom out.

Select a percentage to zoom to from the drop-down list on the data sheet toolbar. The display will zoom to a percent of the default full size.

**To Zoom to Full Screen (YT and XY sheets only)**

Click the third toolbar button to zoom the data sheet display to best fit the current size of the data sheet window.
Procedures

To Zoom On a Waveform Feature (YT and XY sheets only)
Click the fourth toolbar button to begin to zoom in on a waveform feature. Left click and drag to draw a zoom box around the feature to be viewed. Release the left mouse button to complete the zooming.

Change the YT or XY Waveform Display (Properties)
To change the position and scale of a waveform in a YT or XY data sheet, first open a YT or XY data sheet, and drag waveform data from the Explorer View into the data sheet.

To Position a Waveform
For data in both YT and XY data sheets, drag the channel indicator (left of graticule) up and down to vertically position the waveform.
For data in an YT data sheet, drag the waveform record view (above graticule) to horizontally position the selected waveform in the graticule.

To Scale a Waveform
1. Select Properties from the View menu.
2. Select the Graticule tab in the Properties dialog and set the number and size of the horizontal and vertical divisions.
3. Select the desired waveform tab in the Properties dialog; use the pulldown lists to select the horizontal and vertical scale and position settings of the waveform.
4. Click OK to apply the changes and close the Properties dialog.

To Change Waveform Color
To change the color of a waveform after the waveform has been acquired, follow the steps below.
1. While in the XY or YT data sheet, select View | Properties.
2. When the Waveform Properties dialog window appears, select the tab containing the name of the desired waveform, click the color button, select a new color from the Color window, and click OK to accept the color change and close the dialog.
3. Click OK in the Waveform Properties dialog window.

**To Lock the Trigger Points or Horizontal Scales of YT Waveforms**

1. With the YT data sheet selected, select Properties from the View menu.

2. Select the Plot tab in the Properties dialog.

3. Select or deselect the check boxes to toggle locked trigger points and horizontal scales.

4. Click OK to accept the changes and close the Properties dialog.

**To Display the Trigger Point on YT Waveforms**

1. With the YT data sheet selected, select Properties from the View menu.

2. Select the Plot tab in the Properties dialog.

3. Select or deselect the Display Trigger Point checkbox to toggle the trigger point display on the graticule.

4. Click OK to accept the changes and close the Properties dialog.

**To Change the Graticule for XY and YT Data Sheets**

1. With either an XY or YT sheet selected, select Properties from the View menu.

2. Select the Graticule tab in the Properties dialog. In this dialog you can set the following Graticule properties:

   - **Graticule Type.** Select from Full, Grid, Crosshairs, or Frame.
   - **Horizontal Divisions.** Set the number of horizontal divisions.
   - **Vertical Divisions.** Set the number of vertical divisions.
   - **Size of Divisions.** Set the size and dimensions of the horizontal and vertical divisions.
   - **Graticule Color.** Set the graticule color.
   - **Background Color.** Set the graticule background color.
   - **Print black and white.** Toggles the printing color of the data sheet.
Procedures

Set Default. Click Set Default to set the new settings as default.

3. Click OK to accept the changes and close the Properties dialog.

To Change the Plot Style of XY Waveforms

1. With the XY data sheet selected, select Properties from the View menu.

2. Select the Plot tab in the Properties dialog.

3. In the Plot Type pulldown list, select either Dots or Vectors for the plot type. Dots displays the waveform data points as individual dots on the graticule. Vectors displays the waveform data points as a connected line on the graticule.

4. Click OK to accept the changes and close the Properties dialog.

Measure Waveforms using the Waveform Measurement Data Sheet

Drag and drop waveform data from YT, XY, or Waveform Tabular sheet into Waveform Measurement sheet

1. Open a YT, XY, or Waveform Tabular sheet with waveform data in it.

2. Select New from the File menu and select Waveform Measurement Sheet from the New Sheet dialog.

3. Use the mouse to drag the waveform (from the XY or YT sheet) or column of waveform data (from the waveform tabular sheet) to the waveform measurement data sheet. The waveform measurement data sheet will update with measurement values of the waveform data you dragged to it.

Gate and drag and drop waveform data from YT sheet to Waveform Measurement Sheet

1. Open a YT sheet with waveform data in it.

2. Select New from the File menu, and select Waveform Measurement Sheet from the New Sheet dialog.

5-6 WaveStar Software User Manual
3. With the YT sheet selected, select Properties from the View menu. Select the Cursor tab and turn on the Vertical cursors. Check the Gate with vertical bar cursors box; click OK to accept the changes and close the Properties dialog.

4. To gate data, click and drag each cursor until they span the data you want to transfer, and then drag the data to a waveform measurement data sheet.

Gate and drag/drop from Waveform Tabular Sheet

1. Open a waveform tabular sheet with YT waveform data in it.

2. Unlike gates in a YT data sheet, there are no cursors to turn on in a waveform tabular sheet; each waveform table has a column that contains the Start and Stop gates and a trigger point indicator.

3. To gate data, click and drag each gate until they span the data you want to transfer, and then drag the data to a waveform measurement data sheet.

Measure StripChart Plots using Cursors

1. Select New in the File menu, and select StripChart from the New Sheet dialog to open a StripChart data sheet.

2. With the StripChart sheet selected, select Properties from the View menu.

3. Select the Cursors tab in the Properties dialog, and select a cursor type from the pulldown list. Click OK to apply the new settings and close the dialog.

4. Use the mouse to set the cursor positions in the StripChart data sheet.

Set Up Instrument (Data Source)

1. Make sure the GPIB or RS-232 connection from the PC to the instrument is established.
2. With a GPIB or RS-232 connection between the PC and the instrument established, instrument resources, including most control settings, automatically appear in the Explorer view.

3. In the Explorer view, click on the Setup branch under the instrument to be adjusted to expand the instrument setup properties under it.

4. Click the control to be adjusted, and then right click to pop up its shortcut menu.

5. If the shortcut menu entry Selections is not disabled (grayed out), point to it to expand the available selections. If the shortcut menu entry Selections is disabled, select Properties in the menu instead.

6. Click on the control setting of your choice to complete setting up the control.

7. In the Properties dialog box, type in a valid value (for example, 200 mV for CH 1 volts).

8. Press OK to apply your selections; press Cancel to discard them. Both buttons close the Properties dialog box.

Copy the Instrument Screen

To copy an instrument-screen image to a Notes sheet:

1. Choose File \ New. The New data sheet dialog box appears displaying a list of available data sheets from which to select. Select Notes Sheet, and click OK.

2. In the Explorer view, click to first expand the list of connected instruments, and then click the instrument whose screen you intend to copy.

3. Click Display in the instrument resources to access the Screen Copy icon.

4. Left click and drag the Screen Copy icon to the Notes sheet and drop it. The instrument screen appears in the Notes sheet.
Copy the Screen Image to a PC Application

1. Click the title bar of the Notes sheet that contains the bitmap image you want to copy.
2. Click on the bitmap image.
3. Select Edit | Copy.
4. Display the application to receive the bitmap image and paste the image using the application menus (usually the Edit menu).

Restore a Waveform to an Instrument

After acquiring a waveform, follow the steps below to restore that waveform back to an oscilloscope that supports reference waveforms. This way the instrument can operate on the stored waveform (displaying and using the waveform in Math functions, if supported).

1. In the Explorer view, click to expand the Setup branch under the instrument to which the waveform is to be restored. This step displays the reference location that will receive the waveform.
2. Turn on the reference location on the instrument.
3. Click and drag the waveform from a YT sheet (or the data column in tabular sheets) to the reference location in the Explorer view that you displayed in step 1.

If you are restoring a waveform from one instrument back to a different instrument, you need only to drag the waveform and drop it on the new instrument icon in the Explorer view.
4. Release to drop the waveform and store it in the instrument reference location.

Install/Uninstall

See Installation and Uninstallation beginning on page 1–5 for installation and uninstallation procedures.
Connect to Instrument (GPIB & RS-232)

1. Verify that you have the equipment listed in Table 5–1.

<table>
<thead>
<tr>
<th>Required Equipment</th>
<th>Minimum Requirements</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oscilloscope</td>
<td>Tektronix Digital Storage Oscilloscope (DSO) or Digital Phosphor Oscilloscope (DPO)</td>
</tr>
<tr>
<td>Digital Multimeter (DMM)</td>
<td>Tektronix TX-DMM TX1 or TX3 True RMS Digital Multimeter</td>
</tr>
<tr>
<td>RS-232 cable</td>
<td>Verify that the cable used has the correct pin numbers and assignments as the ports on both the oscilloscope and PC.</td>
</tr>
<tr>
<td>GPIB cable</td>
<td></td>
</tr>
<tr>
<td>Infrared (IR) to RS-232 cable</td>
<td>If you are connecting to a TX-DMM series multimeter, you need to use the IR to RS-232 cable supplied with WSTRM WaveStar Software for Meters.</td>
</tr>
<tr>
<td>PC</td>
<td>IBM PC-compatible computer, Windows 95 or NT 4.0, 16 MB RAM, 4X CD-ROM or better, Super VGA monitor or better</td>
</tr>
<tr>
<td>GPIB Interface Card, installed</td>
<td>National Instruments IEEE 488.2 interface card</td>
</tr>
</tbody>
</table>

1 See Supported Instruments on page 1–4 for a complete list of supported Tektronix DSOs and DPOs.

2. Connect your instrument to the PC with the appropriate cable.

3. Turn on the instrument power.
4. If installing a GPIB connection, use the diagnostics supplied with your National Instruments software to verify the GPIB interface in your PC. The GPIB board is required for GPIB connection between your oscilloscope and the PC. If you have problems verifying your GPIB interface, refer to the National Instruments information.

5. To add your instrument to the Instrument Manager Service, go to one of the following procedures in the Instrument Manager Service section beginning on page 2–1:

- **Add Instrument: GPIB Connected**: Use this procedure if communicating with your DSO or DPO using GPIB connection.

- **Add Instrument: RS-232 Connected**: Use this procedure if communicating with your DSO or DPO using RS-232 connection.

- **Add Instrument: IR to RS-232 Connected**: Use this procedure if communicating with a TX-DMM series DMM.

**Saving and Restoring Data Sheets**

Follow the steps below to save and restore a data sheet to the current workbook:

**Save a Data Sheet**

1. Select the title of the data sheet you want to save to make that sheet active and bring it to the front of any other data sheets that are also open.

2. Use one of the following methods for displaying the Save dialog:

   - Select File | Save Data Sheet.
   - Click the Save Data Sheet button in the toolbar.
   - Right click in the data sheet area, and select Save Data Sheet from the shortcut menu that pops up.

3. In the Save dialog, enter a file name and destination for the data sheet. Data sheet files have a .SHT extension.
4. Click OK to save the data sheet and close the dialog.

**Restore a Data Sheet**

1. Open the workbook file in which you will restore the data sheet.

2. Use one of the following methods for restoring the data sheet to a workbook:
   - Select File | Open and select the data sheet file you want to restore. Click OK.
   - Drag the data sheet file from Windows Explorer View and drop it on the data pane.

3. The Reconnect Links dialog appears, prompting you to select Reconnect or Offline.
   - **Reconnect.** Select Reconnect to reconnect the links used when the data sheet was last saved.
   - **Offline.** Select Offline to open the data sheet without restoring the links to the original data sources.

---

**NOTE.** If you select Reconnect and the data source is no longer available, a dialog will appear, and the data sheet will be opened as an offline file (no active links).

---

**Saving and Restoring Workbooks**

Follow the steps below to save and restore a workbook:

**Save a Workbook**

1. Use one of the following methods for displaying the Save dialog:
   - Select File | Save Workbook.
   - Click the Save Workbook button in the toolbar.
2. In the Save dialog, enter a file name and destination for the workbook. Workbook files have a .WK extension.

3. Click OK to save the workbook and close the dialog.

**Restore a Workbook**

1. Use one of the following methods to restore a workbook:
   - Select File | Open and select the workbook file you want to restore. Click OK.
   - Drag the workbook file from Windows Explorer View and drop it on the data pane.

2. The Reconnect Links dialog appears, prompting you to select Reconnect or Offline.

   **Reconnect.** Select Reconnect to reconnect the links used when the workbook was last saved.

   **Offline.** Select Offline to open the data sheet without restoring the links to the original data sources.

**NOTE.** If you select Reconnect and the data source is no longer available, a dialog will appear telling you so, and the workbook will be opened as an Offline file (no active links).

3. If you have a workbook already open, you will be prompted to save. Restoring a saved workbook file closes the current workbook file.
Converting WSTR31 Notebook (*.nbk) Files

To convert a WSTR31 (WaveStar for Windows 3.1) notebook file to a WSTRO (WaveStar for Oscilloscopes) workbook file, do the following procedure:

1. Start the WSTRO program.
2. Select Open from the File menu.
3. In the Files of type field (near the bottom of the Open dialog), select WaveStar 3.1 Notebook Files (*.nbk).
4. Locate the notebook file you want to convert.
5. Click Open.
   
   The notebook sheets are converted and appear in the data sheet pane.
6. Use the Save Workbook as... selection in the File menu to save the converted notebook sheets as a new workbook.

Differences in Converted Files

The following notebook data is not converted to the new Workbook format:

- Harmonic and harmonic tabular data
- Instrument setup data
- Waveform notes in YT and XY data sheets

The following differences may occur in the display of your data:

- Higher resolution waveform drawing methodology may cause waveforms to appear slightly different when viewed at high zoom percentages.
- YT data that was displayed in the dot format is displayed in the vector format.
- Graticule divisions are scaled the same both vertically and horizontally. During the conversion, the graticule is scaled according to the horizontal scale selected in the notebook.
The position of text, the text font, and the text color on converted data sheets may be different than on the original data sheets. The text is movable and you can easily reposition it. You can also select the font you want displayed and the font color.

- Grayscale is now selected from the Print Setup.
- YT and XY data is displayed at 100% zoom.
- Cursors are not displayed on the YT and XY data sheets.
- All waveforms are visible on the YT data sheet.

Saving and Printing Repetitive Snapshots of Data ("Babysitting" Mode)

The Save, Print, and Refresh buttons in the main toolbar accept linked data. This allows you to save, print, or refresh the data sheet or workbook when the data source updates, even if you are not sitting at your PC. Follow the steps below to link data sources to one of these buttons:

1. Select a data sheet that has linked data. While you can link data to a toolbar button directly from the Explorer View, dragging it first to a data sheet allows you set the name of the saved data sheet or workbook file.

2. If you plan to save repetitive snapshots of your data, you should choose the Autoversioning option from the File menu. Selecting this option adds an automatic date and timestamp to the saved filename, which prevents new files from overwriting previous ones.

3. Right click and drag the data source to the toolbar button. When you release the mouse button, select Link in the shortcut menu that pops up. (You can also press Ctrl+Shift and left click and drag the data source to the toolbar button.)

To view or delete a link from a data sheet or toolbar button, right click on the sheet or button and select Show Links from the shortcut menu that pops up. The Show Links dialog appears allowing you to select and delete links.
Viewing Long Record Lengths

You can view and export long record lengths up to 8 MB. The procedure for viewing long record lengths is the same as for viewing any waveform data, with the exception of the memory required to download or export the data.

To print the full record length of all waveforms in the YT data sheet, select the data sheet and choose Print Banner... in the File menu. The Print Banner option is useful when your YT data sheet contains waveforms that are longer than the width of the graticule.

The following table lists memory requirements for downloading and exporting record lengths of 4 MB and 8 MB.

<table>
<thead>
<tr>
<th>Record Length</th>
<th>Memory required to download from oscilloscope</th>
<th>Memory required to export</th>
</tr>
</thead>
<tbody>
<tr>
<td>4 MB</td>
<td>48 MB</td>
<td>60 MB</td>
</tr>
<tr>
<td>8 MB</td>
<td>96 MB</td>
<td>120 MB</td>
</tr>
</tbody>
</table>

Exporting Data

You can export data from any of the data sheets as either comma-separated values (CSV), text, or rich text format (RTF).

1. Select the data sheet from which you want to export data.

2. Select the data items within the data sheet that you want to export.

3. Select the File | Export menu command.

4. In the Export dialog, select the format for the exported data and click OK.
   - CSV: Comma-separated values
   - Text: ASCII text format
   - RTF: Rich text format
5. In the File Save As dialog, enter a file name and location for the export file, and click OK.

While the export is running, a counter is displayed that shows how many records have been exported and written to the export file. Click Stop at any time to stop the export. This is especially helpful when exporting long record lengths.

When displayed, data in the export file looks exactly like what you would get if you dragged and dropped the data to Microsoft Excel or Word, except using the Export command writes this data to a file instead of displaying it in an external application.
WSTRM WaveStar Software for Meters and Virtual Instrument Software

This section outlines information specific to WSTRM WaveStar Software for Meters.

Specifications

Specifications listed in Table 6–1 are for the Infrared RS-232 serial communications cable. All specifications are warranted, unless noted as typical, for operation in an ambient temperature. Refer to the instrument user manual for the specifications of the TX-DMM multimeter.

Table 6–1: Specifications for the Infrared RS-232 cable

<table>
<thead>
<tr>
<th>Characteristic</th>
<th>Specification</th>
</tr>
</thead>
<tbody>
<tr>
<td>RS-232 compatibility</td>
<td>Infrared (IR) to 9-pin RS-232 serial communications</td>
</tr>
<tr>
<td>Connectors</td>
<td>PC: 9-pin female D-sub connector</td>
</tr>
<tr>
<td></td>
<td>DMM: Proprietary male IR coupler</td>
</tr>
<tr>
<td>Temperature</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>0°C to 50°C</td>
</tr>
<tr>
<td>Non-operating</td>
<td>–20°C to +60°C</td>
</tr>
<tr>
<td>Humidity</td>
<td></td>
</tr>
<tr>
<td>Operating</td>
<td>Maximum: 80% relative humidity in 30°C to 50°C range</td>
</tr>
<tr>
<td>Non-operating</td>
<td>Maximum: 80% relative humidity in 30°C to 60°C range</td>
</tr>
<tr>
<td>Physical Characteristics</td>
<td></td>
</tr>
<tr>
<td>Length</td>
<td>210 cm ±10 cm</td>
</tr>
<tr>
<td>Weight</td>
<td>100.5 g</td>
</tr>
</tbody>
</table>
Setup

Before using the WSTRM WaveStar Software for Meters or the Virtual Instrument software, you first need to connect your TX-DMM series DMM to your PC using the infrared (IR)-to-RS-232 cable provided. Follow the steps below to connect your DMM and PC, referring to the illustration as needed.

1. Press the boot insert into place in the top of the DMM protective boot. Connect the WSTRM cable to the boot insert.

2. Connect the other end of the WSTRM cable to your computer serial port using the 9-pin connector. If you require a 25-pin connection to your PC, you will need to use the included 9-pin-to-25-pin adapter.


Functional Check

Use one of the following methods to perform a functional check of the cable:

Method 1:

1. Set up the meter and cable. See page 6–2.
3. Add your meter to the instrument list using Instrument Manager Service. See page 2–10.

A successful connection to your meter indicates a passing functional check.

Method 2:

1. Set up the TX DMM through the Instrument Manager Service (refer to Add Instrument: Infrared (IR) to RS-232 Connected on page 2–10).
2. Open the Virtual Instrument application.
3. Select About from the Help menu.

If the About dialog correctly displays the name, model number, firmware version number, and serial number of your meter, the functional check passed.

If the functional check fails, refer to Troubleshooting.

Troubleshooting

If your instrument fails the functional check, refer to the troubleshooting flow chart on page 6–4 and the text following it to perform the communications port test and the TX-DMM cable tests.

To determine if the failure of the functional check is because of a fault in the RS-232-C communications port, you will need to build a loop back test fixture and perform a communications port test. To build the fixture, you will need either a 9-pin DB9 female connector or a 25-pin DB25 female connector, whichever one matches your RS-232 communications port.
Wire strap the pins on the connector as follows (see the following illustration):

- Connect the TxD and RxD pins together.
- Connect the CTS, RTS, and DCD pins together.
- Connect the DSR and DTR pins together.
Communication Port Test. To test the communications port, perform the following procedure:

1. Install the loop back test fixture on the RS-232 port that you are testing.

2. Open Microsoft HyperTerminal, and use the default settings to make a new connection to the communications port that you are testing.

NOTE. HyperTerminal is part of the Microsoft Windows 95 or Windows NT operating system. It is typically accessed by selecting Start, Programs, Accessories, HyperTerminal. If it is not present on your PC, contact your System Administrator (or load it from your operating system disk).
3. Enter some characters from the keyboard. The characters should display on your monitor.

   If the characters are not displayed on the monitor, verify that you are connected to the right communications port. If you are, then the communications port has a fault. Refer the problem to your system hardware or computer repair personnel.

4. If the characters were displayed on the monitor in step 3, then disconnect the loop back test fixture from the communications port. Enter some characters from the keyboard.

   If the characters do not display, the loop back test fixture is working properly, and the communications port is functioning.

**TX-DMM Serial Cable Test.** You will need the following components to run this test:

- The TX–DMM Infrared (IR) RS-232 Cable
- The boot insert (shown in the figure on page 6–2), used to obtain the proper spacing between the cable and the mirror.
- A small mirror.

Test Procedure.

1. Connect the TX–DMM RS-232 cable to your PC.

2. Connect the boot insert to the free end of the RS-232 cable.

3. Open HyperTerminal on your PC, and make a new connection to the COM port that you are using. Use the Default settings.

4. Hold the RS-232 cable and boot insert flat against the mirror so that the LEDs are facing the mirror. Type some characters using the keyboard; you should see what you are typing on the computer display.

5. To verify the test, take the cable away from the mirror and type on the keyboard. What you are typing should not appear on the computer display.
Virtual Instrument Software Overview

The illustration below shows the WSTRM WaveStar Software for Meters virtual instrument user interface. As you can see, it is an exact replica of a TX-DMM true RMS digital multimeter.

Once you have established a good connection between your TX-DMM series DMM and your PC, you can use the virtual instrument software to control your DMM by simply using the menu commands and mouse to select different DMM controls and settings.
This section outlines each menu command, toolbar button, and setting you can use with the Virtual Instrument software.

**DMM Instrument Image**

Operating the DMM using the image on the PC is identical to operating the instrument itself, and the LCD readout on the PC is identical to the LCD on the DMM.

**Terminology**

Using a mouse to press an on-screen button is obviously different than pressing the actual button on your DMM. To help you understand how you can control your DMM using this application, use the following terminology.

**“Button Presses”**

You press a button by moving the mouse pointer over the desired DMM button (at which point the mouse pointer changes to a hand) and clicking the left mouse button. The action is performed when you click the mouse button.

**“Button Holds”**

You hold a button by continuing to hold the left mouse button down while keeping the mouse pointer over the DMM button for 1 second. If you release the mouse button or move the mouse pointer off the DMM button before 1 second expires, the DMM button is released and the hold action does not occur.
“Knob Turns”
You turn the DMM knob to a particular function by moving the mouse pointer over the desired function and pressing the left mouse button. You can drag the knob by clicking and holding the left mouse button on the knob and moving the mouse pointer to the new position. If you drag the mouse pointer to an invalid knob position (clockwise beyond Amps, counter clockwise past Off, or outside the knob’s radius) the dragging operation is cancelled.

Off Function
You can now turn the Measurement Knob to the Off position on the virtual instrument image. This selection (new in WaveStar Software for Meters, version 2.1) allows you to remotely power on or power off the DMM. You can right click the Measurement knob at the OFF position to select power off. This feature also now appears in the Explorer View Pane under Setup as shown in the following illustration.

NOTE. If the DMM is powered down, it will take approximately 10 seconds to power up the DMM and re-establish the connection.

Using the virtual image user interface or the Power selection in the WaveStar Explorer View Panel to power off the DMM puts the DMM to sleep. To totally shut the instrument off, you must physically turn the Measurement Knob to Off on the actual DMM.
Menu Commands

This section describes each menu command.

File Menu

The file menu contains commands for printing and exiting the application.

Print. This selection will send the DMM image to a printer. The image height is adjusted to fill the vertical size of the print area. The image width is adjusted proportionately to maintain the aspect ratio. The image is centered vertically and horizontally within the print area. The image will be printed in color on a color printer and will be printed in monochrome on a monochrome printer. The monochrome image will print in gray-scale if supported by the printer.

Print Setup. This selection brings up the standard Print Setup dialog box, which allows you to select the printer, paper size, source, and orientation.

Exit. This selection exits the application. Several aspects of the application setup are saved in the registry to be used as default value when the application is started again. The setups that are saved are the copy selection option (LCD or All), the toolbar and status bar view option (displayed or not), and the size and position of the window.

Edit Menu

The Edit menu commands let you set the copy selection state and copy either the entire image or just the LCD display to the clipboard.

Select All. This selection sets the selection state so the next time you do Edit | Copy, the entire DMM image will be copied to the clipboard. The first time you start the application, this is the default selection. For subsequent selections, the selection state at start-up will be restored to what it was when you last closed the application.

Select LCD. This selection sets the selection state so the next time you do Edit | Copy, only the LCD image will be copied to the clipboard. The selection state at start-up will be restored to what it was when you last closed the application.
Copy. This selection copies either the entire DMM image or the just the LCD image to the clipboard. Use Edit | Select All or Edit | Select LCD to choose the image you want to have copied.

View Menu

Menu commands in the View menu let you control the toolbar and status bar display, as well as the size of the user interface.

Toolbar. This selection turns the toolbar display on and off. The first time you start the application, the toolbar is shown. For subsequent selections, the toolbar display status at start-up will be restored to what it was when you last closed the application.

Status Bar. This selection toggles the visibility state of the status bar. The first time you start the application, the status bar is shown. Subsequently, the visibility state at start-up will be restored to what it was when you last closed the application.

Enlarged LCD. This selection shows a separate window that displays the LCD image only. This is a sizeable window whose aspect ratio is not maintained, so you can size it however you want. You can use the standard Windows Alt+Print Screen to copy a bitmap image of this window to the clipboard.

Large. This selection sets the application window to the largest of its three fixed sizes. The window includes the full image of the DMM.

Medium. This selection sets the application window to the middle of its three fixed sizes. The features are the same size as in the Large image, but it does not show the nonessential area around the perimeter, such as the boot, connectors, and some of the perimeter. This window is intended to fit inside a screen resolution of 800x600, with the toolbar and status bar turned off.

Small. This selection sets the application window to the smallest of its three fixed sizes. The items shown are the same ones as in the Medium image, but the height and width are 80% of the size of the Medium size. This window is intended to accommodate a screen resolution of 640x480, with the toolbar and status bar turned off.
Settings Menu

The Settings menu commands let you turn the DMM power on or off, control power-up settings, and reconnect an instrument connection.

**Power-On Settings.** This selection allows you to establish the DMM power-on settings for the instrument. These settings have the same action as pressing and holding one of the front-panel buttons while turning on the meter.

---

**NOTE.** The command to Disable Auto-Off is not independently supported by a menu selection because Auto-Off is automatically disabled whenever any remote command is received by the instrument.

---

Listed below are the power-on settings you can use with the virtual instrument application:

- **500 mV Hi-Z.** This sets the 500 mV High Impedance mode. This is the same as pressing and holding the Range button when turning on the DMM.

- **1sec M/M/A.** This sets the 1 second M/M/A mode. This is the same as pressing and holding the M/M/A button when turning on the DMM.

- **No Beeper.** This turns the beeper off. This is the same as pressing and holding the Delta button when turning on the DMM.

- **High Resolution.** This sets the High Res - 50,000 Counts mode. This is the same as pressing and holding the Blue button when turning on the DMM.

- **No Light Auto-Off.** This Disables Light Timeout for the backlight. This is the same as pressing and holding the Light button when turning on the DMM.

- **Clear All.** This resets all power-up modes. This is the same as turning on the DMM with NO buttons held.

**Reconnect.** If you have two or more DMMs connected to the PC, you can use this item to choose which DMM will be controlled by this
application. The instrument’s alias, as set in the Instrument Services Manager, is shown on the application’s title bar. If you have a single DMM connected to the PC, this menu item has no effect.

When you start the application, and two or more DMMs are connected to the PC, the list of instruments is presented to you to choose the DMM that will be controlled.

**Help Menu**

The Help menu commands give you access to the online help topics and to information about the software and hardware.

**Contents and Index.** This selection activates the top-level view of the application’s online help system.

**What's this?** This selection turns the normal mouse pointer into a What’s This? help pointer. You can then select a menu command, toolbar button, or area of the user interface to display context-sensitive online help about that topic.

**TxDmm Overview.** This selection displays the TxDmm Overview online help topic.

**Technical Support.** This selection displays information on how to contact Tektronix technical support.

**About TxDmm.** This selection brings up the Help About dialog box. In addition to showing the application name, version and copyright notice, it shows pertinent information about the presently connected DMM: Model Number, Serial Number, Firmware Version and the Last Calibration Date.

**Toolbar**

The toolbar provides shortcuts to the corresponding menu items:

- Edit | Select All
- Edit | Select LCD
- Edit | Copy
- File | Print
- Help | About
- A button to activate context-sensitive help.

**Status Bar**

This displays a one-line description of the toolbar button or menu selection the mouse pointer is positioned over.
User Proxy Table Utility

The WaveStar User Proxy Table Creation Utility is an application that helps you build instrument proxy files interactively. Instrument proxy files consist of simple commands and queries that the utility uses to program those instruments for which instrument proxies are not available. You can use this utility with WaveStar Software for Oscilloscopes and with WaveStar Software for Meters.

Proxy File Overview

Instrument Proxy files are user-readable ASCII files, with read and write permissions enabled. Each file consists of records that describe the commands and queries to be used to program various settings in the instrument. The records can also contain information on the data type of any argument taken by the command, the response string that will be returned by the query and read/write privileges.

The proxy table files can only contain commands and queries that take or return simple, nonaggregate data. Commands and queries that handle aggregate data, like arrays or structures, cannot be used in the file.

Records

A typical record in the file will look as follows:

add(CH1.Bandwidth), command(:CH1:BAN%s), query(:CH1:BAN?/r), response(%s), type(String), access(rw), enum(TWENTY,HUNDRED,FULL);

In the above example, the name of the setting described by the record is CH1.Bandwidth. The string to be used to program the setting is specified by the Command field. The string to be used to query the setting is specified by the Query field. The Type field specifies the nature of the argument taken by the command. Access rights are specified by the Access field.
Fields within a record are separated by commas, while records themselves are separated by semi-colons.

**Initialization Commands**

You can specify a set of initialization commands in the file, which the WaveStar application will use to initialize the instrument during the process of establishing a connection. Initialization commands are preceded by the keyword ‘init’, while normal commands are preceded by the keyword ‘add’.

A typical initialization command looks as follows:

```plaintext
init(:CH1:BAN:TWENTY/r);
```

The WaveStar application will issue the above statement to the instrument at the time of establishing the connection, setting the instrument bandwidth to TWENTY. You can specify multiple initialization records, but you must separate them with semi-colons.
Main Screen

When you open the User Proxy Table Utility, the application opens the main screen. This dialog is used to add a new record or modify an existing record. For a new file, the list box and controls will be empty. If you open an existing file the list box will display the records in the file and the controls show corresponding fields of the first record. The columns of the list box correspond to the different fields comprising a record.
**File Menu**

<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Ctrl+N</td>
</tr>
<tr>
<td>Open</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Save</td>
<td>Ctrl+S</td>
</tr>
<tr>
<td>Save As</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>Settings</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Instrument1.ipr</td>
<td></td>
</tr>
<tr>
<td>Exit</td>
<td></td>
</tr>
</tbody>
</table>

**New.** Select New to open a new main screen with no records in the list box. The application can open only one file at a time, so if you select New, the currently open file will be closed (you will be prompted to save this file before it is closed). By default, new files are titled Instrument 1.

**Open.** Select Open to open a previously saved file.

**Save.** Select Save to save the open file to a directory. Files are saved with an .ipr extension.

**Save As.** Select Save As to save the open file with a new name or in a new location.

**Settings.** Select Settings to open the User Proxy Registry Settings dialog. See *Registry Screen* on page 7–9 for further information.

**<Recent Files>.** This section of the File menu displays all recently opened files.

**Exit.** Select Exit to close the application.
Record Menu

<table>
<thead>
<tr>
<th>Record</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>New</td>
<td>Alt+N</td>
</tr>
<tr>
<td>Cut</td>
<td>Alt+X</td>
</tr>
<tr>
<td>Copy</td>
<td>Alt+C</td>
</tr>
<tr>
<td>Paste</td>
<td>Alt+V</td>
</tr>
<tr>
<td>Initialization Record</td>
<td>Ctrl+I</td>
</tr>
<tr>
<td>Home</td>
<td>Ctrl+H</td>
</tr>
<tr>
<td>End</td>
<td>Ctrl+Q</td>
</tr>
</tbody>
</table>

**New.** Select New in the Record menu to commit (save) the current record and clear the controls for entering a new record. If you were modifying the current record, you must first click Update to update the record file; otherwise the modifications will be lost. Records are saved to file in the same order they are displayed in the list box.

**Cut.** Select Cut to cut the selected record from the list box. The cut record is put on the clipboard.

**Copy.** Select Copy to copy the selected record.

**Paste.** Select Paste to paste the record in the clipboard to the list box. The record is pasted above the currently selected record in the list box.

**Initialization Record.** Select Initialization Record to open the Initialization Commands dialog. See *Initialization Screen* on page 7–8 for further information.

**Home.** Select Home to select the first record in the file and show the corresponding controls.

**End.** Select End to select the last record in the file and show the corresponding controls.
Help Menu

Select About Proxytbl... in the Help menu to display the About Proxytbl dialog showing the product name, version number, and copyright information.

Toolbar

1 New file
2 Open a file
3 Save file
4 Move to first record in list
5 Move to previous record in list
6 Move to next record in list
7 Move to last record in list
8 Display About Proxytbl dialog

Toolbar Buttons

There are four toolbar buttons in the main screen that control the current record (see the illustration on page 7–3):

New. Click this button to insert a new, blank record above the currently selected record.

Update. Click this button to commit (save) the current record. Any changes you have made in the controls will appear in the list box.

Clear. Click this button to clear the edit controls and entry fields.

Cut. Click this button to cut the currently selected record from the list box. The cut record is placed on the Windows clipboard.

Control Settings

There are nine control settings in this dialog that allow you to control the record.
Setting. This control specifies the name of the instrument setting described by the record.

Command. This control specifies the command to be used to program the setting in the instrument. The command control is disabled if the access control is set to read-only.

Query. This control specifies the query to be used to read the setting from the instrument. If you do not specify a query control, the response control is disabled. The query control is disabled if the Access control is set to write-only or execute.

Response. This control specifies the type of response expected when the setting is queried. This control is disabled if no query control is specified.

Access. This control specifies the read/write access of the setting. Settings with write-only access cannot be queried. You can not write to settings with read-only access. Read settings disable the command control. Write settings disable the query and response controls. Execute settings set the Data type control to Method and disable all controls except Setting, Command, and Data Type.

Data Type. This control specifies the type of argument that the Command control will take. For Method data type settings, the Access control is set to Execute.

Enum List. This control is used to input comma-separated enumerated values. These values must be comma-separated.

Units. This control specifies the units to be associated with the setting.

List Box. The list box displays the partial set of records in the currently open file. You can view any record in the file by selecting the record in the scrolling list.
Initialization Screen

The Initialization Commands dialog has a scrollable edit box that displays initialization commands that have been previously entered or read from the Initialization Section of the file.

You can add, delete, and modify the initialization commands. Each command has to be entered on a new line. Click OK to save the initialization commands and store and add them to the Initialization Section of the file when the file is saved. Click Cancel to dismiss the dialog without saving changes.
Registry Screen

Use the User Proxy Registry Settings dialog to enter registration information for the file. You can access the Registry Settings by selecting Settings from the File menu. The dialog is also displayed when you save or close the file.

![User Proxy Registry Settings dialog]

If there is an entry for the current file in the registry, the values in this entry are read and displayed in the dialog; otherwise the dialog is brought up with default values in the fields. You can modify these values and overwrite the existing registry entries.

At startup, the application checks the registry to see if there is any top-level key containing the UserProxyProgId ("UIser.InstrConnection.1") and Type (0x796e6164). If such key is unavailable, the utility creates it, and updates LastProxyId. If necessary, the application builds the whole Software\Tektronix\InstSvr\Available Proxies tree under HKEY_LOCAL_MACHINE key.

If there is no registry entry under the UserProxy top-level key corresponding to the file name being edited, the application creates a new entry with the same name as the open file and saves the settings under it.

There are four entry fields and two buttons that control the User Proxy Registry Settings dialog:

- **Instrument Family Member Name:** This field displays the name of the file that is being registered.
- **VISA Filter:** This is a user-editable field that shows the value of the VisaFilter registry key if available. This key determines the communication (GPIB or RS-232) settings of the instrument. If this registry key is not available, this field shows, by default, GPIB?*INSTR:ASRL?*INSTR.

- **VISA Defaults:** This is a user-editable field that shows the value of the VisaDefaults registry key if available. This key determines the default RS-232 baud rate, data bits, parity, and flow control settings of the instrument. If this registry key is not available, this field shows, by default,
  
  VI_ATTR_ASRL_BAUD=9600,VI_ATTR_ASRL_DATA_BITS=8,VI_ATTR_ASRL_PARITY=0, 
  VI_ATTR_ASRL_FLOW_CNTRL=2.

- **VISA Settings:** This is a user-editable field that shows the value of the VisaSettings registry key, if available. This key determines the user-edited baud rate, data bits, parity, and flow control settings of the instrument. If this registry key is not available, this field shows, by default,
  
  VI_ATTR_ASRL_BAUD=9600,VI_ATTR_ASRL_DATA_BITS=8,VI_ATTR_ASRL_PARITY=0, 
  VI_ATTR_ASRL_FLOW_CNTRL=2.

- **OK Button:** Click this button to save currently displayed registry settings and close dialog.

- **Cancel Button:** Click this button to dismiss the dialog without changing the registry settings.
RS-232

This section provides instructions to set the default RS-232 values on various Tektronix oscilloscopes and some general troubleshooting help.

Setting RS-232 Default Values

Refer to the information in this section for RS-232 interface connections for your specific oscilloscope family.

**TDS 200, TDS 300, TDS 3000, and THS 700 Series**

If you are using a TDS 200 Series, TDS 300 Series, TDS 3000 Series, or THS 700 Series oscilloscope, you can use the Set RS-232 Parameters to Default Values button to set the RS-232 settings on the oscilloscope to the WaveStar default values.

**TDS 200 Series Oscilloscopes.** Follow the steps below to access the Set RS-232 Parameters to Default Values button:

1. Push the Utility button on your oscilloscope.
2. Push the Options bezel button.
3. Push the RS232 Setup bezel button.
4. Push the Set to defaults bezel button to set the RS-232 settings to the WaveStar default settings.

You can examine the Error Log for clues about your RS-232 interface connection. Follow the steps below to access the Error Log:

1. Push the Utility button on the oscilloscope.
2. Push the Error Log bezel button.
3. Use the bezel buttons to page through the Error Log display.

Check the lines in the Error Log titled RS-232 Line Snapshot and RS-232 Errors. Refer to the programmer manual for your oscilloscope for information about interpreting the information in the Error Log.
**TDS 300 Series and TDS 3000 Series Oscilloscopes.** Follow the steps below to access the Set RS-232 Parameters to Default Values button:

1. Push the Utility button on your oscilloscope.

2. Push the bottom left bezel button repeatedly until I/O is selected.

3. Push the RS-232C (RS232 for the TDS 3000 Series) bezel button. The side bezel buttons now control the RS-232 settings.

4. Push the fourth bezel button (fifth bezel button for TDS 3000 Series) on the side to set the default RS-232 settings to the WaveStar default values.

You can examine the Error Log for clues about your RS-232 interface connection. Follow the steps below to access the Error Log:

1. Push the Utility button on the oscilloscope.

2. Push the bottom left bezel button on the oscilloscope repeatedly until Diag is selected.

3. Push the bezel button on the oscilloscope labeled Error Log. TDS 3000 Series oscilloscopes display the Error Log. (For TDS 300 Series oscilloscopes, push the side bezel button labeled Display Log to display the Error Log.)

Check the lines in the Error Log titled RS-232 Line Snapshot and RS-232 Errors. Refer to the programmer manual for your oscilloscope for information about interpreting the information in the Error Log.

**THS 700 Series Oscilloscopes.** Follow the steps below to access the Set RS232 Parameters to Defaults button.

1. Push the Utility button on the oscilloscope.

2. Push the bottom left bezel button (System Config) on the oscilloscope repeatedly until RS-232 is selected.

3. Push the fifth bezel button on the oscilloscope (labeled Set RS232 Parameters to Defaults).
You can examine the Error Log for clues about your RS-232 interface connection. Follow the steps below to access the Error Log:

1. Push the Utility button on the oscilloscope.

2. Push the bottom left bezel button on the oscilloscope repeatedly until Diag is selected.

3. Push the bezel button on the oscilloscope labeled Error Log.

4. Push the adjacent bezel button labeled **OK Display Log to display the Error Log.**

Check the lines in the Error Log titled RS-232 Line Snapshot and RS-232 Errors. Refer to the programmer manual for your oscilloscope for information about interpreting the information in the Error Log.

**TDS 400, 500, 600, 700, or 800 Series**

The TDS 400, 500, 600, 700, and 800 Series oscilloscopes support RS-232 printers but cannot be controlled over the RS-232 interface. WaveStar Software can only communicate with these series of oscilloscopes using a GPIB interface connection.
RS-232 General Hints

- Make sure the communication parameters are set correctly on both the oscilloscope and WaveStar. Baud rates should be the same, Parity should be None, Data Bits should be 8, and Stop Bits should be 1.

Soft flagging should never be used for waveform and hardcopy transfers. This is because waveform data and hardcopy output contain binary characters which can easily include the XON and XOFF characters used to implement soft flagging. Soft flagging should only be used for transferring stored setups since stored setup information generally consists of printable ASCII text.

- Although it generally should not matter if the EOL characters are the same, set the EOL to CRLF to be sure there are no problems.

- Not all instruments support full RS-232 communications. Some instruments only support GPIB communication, while others support limited RS-232 functions, such as printer functions.

- If you are able to connect to an instrument but unable to transfer waveforms successfully, you may have a cable that is not wired correctly for hard flagging.

If you can successfully transfer settings to and from the instrument at the fastest supported baud rate, hard flagging is probably working. If not, try soft flagging. If you can successfully transfer settings using soft flagging but not with hard flagging, there is a good chance the hard flagging lines of your cable are not connected properly.
RS-232 Cable Issues

If the information provided so far in this section fails to resolve your RS-232 problems, it may be that you are using an incompatible RS-232 cable. There is no such thing as a standard RS-232 cable, so you may need to use an ohmmeter to verify that your cable is wired correctly. Many cables do not have all of the pins connected.

Determine whether the PC and oscilloscope are DTE (Data Terminal Equipment) or DCE (Data Communications Equipment) devices. This information is in the documentation provided with your oscilloscope and with your PC.

If you are connecting a DTE device to a DCE device you will need a straight-through cable. This is a cable that has the same pin assignments on both ends of the cable.

If you are connecting two devices of the same type, you need a null modem cable. This is a cable whose lines are crossed such that the inputs of one device are connected to the outputs of the other.

⚠️ CAUTION. Do not connect the output lines of two same-type devices to each other. Doing so will damage one or both of the devices.

For hard flagging to work, the RTS (Request To Send) and CTS (Clear To Send) lines must be connected. Use an ohmmeter to verify that they are actually connected since not all cables connect these lines. The RTS line is sometimes referred to as RFR.

The DCD (Data Carrier Detect) line is not used by WaveStar so it does not matter whether or not it is connected. The DCD line is sometimes referred to as RLSD.
RS-232 Cable Examples

The information in this section provides correct wiring and pin assignments for RS-232 interface connections with each type of oscilloscope supported by WaveStar Software.

TDS 200 and TDS 300 Series Oscilloscope to PC (DB9 female to DB9 male)

Table 8–1 lists the correct wiring for connecting a TDS 200 Series or TDS 300 Series oscilloscope with 9 pins to a 9 pin serial port on a DTE PC. TDS 200 Series and TDS 300 Series instruments are DTE devices.

Table 8–1: Pin assignments for TDS 200 or TDS 300 Series oscilloscope (DB9 to DB9)

<table>
<thead>
<tr>
<th>TDS Line</th>
<th>DB9 Female Pin Number</th>
<th>PC Pin</th>
<th>DB9 Female Line Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>(RxD)</td>
<td>2</td>
<td>3</td>
<td>(TxD)</td>
</tr>
<tr>
<td>(TxD)</td>
<td>3</td>
<td>2</td>
<td>(RxD)</td>
</tr>
<tr>
<td>(DTR)</td>
<td>4</td>
<td>6</td>
<td>(DSR)</td>
</tr>
<tr>
<td>(GND)</td>
<td>5</td>
<td>5</td>
<td>(GND)</td>
</tr>
<tr>
<td>(DSR)</td>
<td>6</td>
<td>4</td>
<td>(DTR)</td>
</tr>
<tr>
<td>(RTS)</td>
<td>7</td>
<td>1, 8(^1)</td>
<td>(CTS)</td>
</tr>
<tr>
<td>(CTS)</td>
<td>8</td>
<td>7</td>
<td>(RTS)</td>
</tr>
</tbody>
</table>

\(^1\) Pins 1 and 8 are wired together.
Connecting Two Like Devices (DCE to DCE or DTE to DTE)
Using Null Modem Cable

Table 8–2 lists the correct wiring for connecting two like devices together using a DB25 female to DB25 female cable.

Table 8–2: Pin assignments for DB25 Female to DB25 Female Null Modem Cable

<table>
<thead>
<tr>
<th>DB25 Female 25 Pin Connector</th>
<th>DB25 Female Pin Number</th>
<th>PC Pin</th>
<th>Line Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>Chassis Ground</td>
<td>1</td>
<td>1</td>
<td>Chassis Ground</td>
</tr>
<tr>
<td>(TxD)</td>
<td>2</td>
<td>3</td>
<td>(RxD)</td>
</tr>
<tr>
<td>(RxD)</td>
<td>3</td>
<td>2</td>
<td>(TxD)</td>
</tr>
<tr>
<td>(RTS)</td>
<td>4</td>
<td>5</td>
<td>(CTS)</td>
</tr>
<tr>
<td>(CTS)</td>
<td>5</td>
<td>4</td>
<td>(RTS)</td>
</tr>
<tr>
<td>(DSR DCD)</td>
<td>6, 8¹</td>
<td>20</td>
<td>(DTR)</td>
</tr>
<tr>
<td>(DTR)</td>
<td>20</td>
<td>6, 8¹</td>
<td>(DCR DCD)</td>
</tr>
<tr>
<td>(Signal GND)</td>
<td>7</td>
<td>7</td>
<td>(Signal GND)</td>
</tr>
</tbody>
</table>

¹ Pins 6 and 8 are wired together.
Most GPIB problems are caused by the general errors listed in Table 9–1.

Table 9–1: Common GPIB Errors

<table>
<thead>
<tr>
<th>Problem</th>
<th>Solution</th>
</tr>
</thead>
<tbody>
<tr>
<td>Loose Cable</td>
<td>Make sure cables are securely connected to both the PC and the oscilloscope.</td>
</tr>
<tr>
<td>Improper Cable</td>
<td>Make sure pin numbers and assignments are correct for both the PC and oscilloscope.</td>
</tr>
<tr>
<td>Wrong GPIB Address</td>
<td>Make sure you have selected the correct address. WaveStar provides addresses 1 through 30. Check the GPIB address of your instrument. The address is an instrument function, so refer to your instrument User Manual for instructions on how to check the GPIB address.</td>
</tr>
<tr>
<td>Timeout Value too Slow</td>
<td>Set the timeout value to a faster time. Slower baud rates require very long timeouts and long timeouts cause long error recoveries</td>
</tr>
<tr>
<td>Windows GPIB Drivers not Installed</td>
<td>Install the proper Windows GPIB drivers.</td>
</tr>
<tr>
<td>Old Version of GPIB Drivers</td>
<td>Upgrade to National Instruments Version 2.7.2 or later.</td>
</tr>
</tbody>
</table>
If you experience problems using GPIB communication, use the steps below to try to resolve the problem. Usually, problems have a simple cause such as an incorrect address or faulty cable. If the procedures below or other GPIB-related help information does not fix the problem, contact Tektronix Technical Support for further help.

First, make sure you are using the proper equipment to establish the GPIB connection:

- National Instruments GPIB Interface card (IEEE Std 488.2) Version C.12 or later
- GPIB Cable

After verifying you are using the proper GPIB equipment, follow the steps below.

1. Disconnect all GPIB cables from PC.
2. Run the hardware diagnostics supplied with the GPIB card.
3. Run the software diagnostics supplied with the card.
4. If the GPIB diagnostics fail, or if you have difficulty running them, contact National Instrument Technical Support.
5. If the GPIB diagnostics pass, contact Tektronix. (See page NO TAG for information on how to contact Tektronix.)
Index

A
ASRL, 2–5

B
babysitting, 5–15
baud rate, 2–5

C
changing
  waveform color, 5–4
  waveform position, 5–4
  waveform scale, 5–4
connect to instrument, 5–10
converting WSTR31 notebook files, 5–14
copying
  instrument screen, 5–8
  screen image to another application, 5–9
copying data, 3–6, 4–2

D
data bits, 2–6
data sheet
  common behavior, 4–1
  compatible data between sheets, 4–4
  property sheets, 4–3
  YT, 4–5
data sheet pane, 3–5, 4–1
datalog measurement sheet
  copying vs. linking, 4–18
  I/O operations, 4–17
overview, 4–17
property sheet, 4–18
start recording, 4–18
stop recording, 4–18
datalog tabular sheet
  copying vs. linking, 4–14
I/O operations, 4–13
overview, 4–13
property sheet, 4–14
start recording, 4–14
stop recording, 4–14
DCOM, installation, 1–6
default RS–232 parameters
  setting for TDS 200 series, 8–1
  setting for TDS 300 and 3000 series, 8–2
  setting for THS 700 series, 8–2
displaying
  trigger point, 5–5
  two waveforms in XY sheet, 5–2
  waveform is YT sheet, 5–1
drag and drop data to waveform measurement sheet, 5–6
dynamically position waveforms, 5–3

E
edit menu, 3–3
Explorer view, 3–5
export, 5–16

F
file menu, 3–3
flow control, 2–6
Index

G

gate and drag and drop data to waveform measurement sheet, 5–6
gate and drag and drop from waveform tabular sheet, 5–7

GPIB
adding instrument to IMS, 2–8
common errors, 9–1
resolving problems, 9–2
terminator, 2–8
timeout rate, 2–8
graticule properties, 5–5

H
help menu, 3–4

I
installing
WSTRM, 1–9
WSTRO, 1–5
WSTROU, 1–5
Instrument Manager Service (IMS)
activity log
display, 2–13
print, 2–14
adding an instrument connected to the AD007 Adapter, 2–10
adding GPIB instrument, 2–8
adding IR to RS-232 instrument, 2–10
adding RS-232 instrument, 2–5
main screen overview, 2–1
menu bar, 2–2
reconnect to instrument, 2–13
remove an instrument, 2–11
set instrument permissions, 2–14
shutting down service, 2–12
switching instrument online or offline, 2–12
toolbar, 2–4
use existing connections, 2–13

K
key, for installation, viii

L
linking data, 3–7, 4–2
lock horizontal scale, 5–5
lock trigger points, 5–5
long record lengths, 5–16

M
measure strip chart plot using cursors, 5–7
Microsoft Office, copying data into, 4–3
mouse operations, 3–2

N
National Instruments, IEEE interface card, 1–3
notebook files, converting to workbook files, 5–14
notes sheet
operations, 4–20
overview, 4–19
supported applications, 4–20
O

offline, switching an instrument,  
2–12
online, switching an instrument, 
2–12

P

parity, 2–6
permissions, set for instrument, 
2–14
Print banner, 4–7
printing full record length, 4–7
procedures
babysitting, 5–15
change graticule properties, 5–5
change waveform plot style, 5–6
change waveform position, 5–4
change waveform scale, 5–4
connect to instrument, 5–10
copy instrument screen, 5–8
copy screen image to another 
application, 5–9
display trigger point, 5–5
display two waveforms in XY 
 sheet, 5–2
display waveform in YT sheet, 
5–1
drag and drop data to waveform 
measurement sheet, 5–6
dynamically position waveforms, 
5–3
gate and drag and drop data to 
waveform measurement 
 sheet, 5–6
gate and drag and drop from 
waveform tabular sheet, 5–7
lock horizontal scale, 5–5
lock trigger points, 5–5
measure strip chart plot using 
cursors, 5–7
restore data sheet, 5–12
restore waveform to instrument, 
5–9
restore workbook, 5–13
save and print repetitive data, 
5–15
save data sheet, 5–11
save workbook, 5–12
set up data source, 5–7
zoom, 5–3
properties, setting, 4–3

R

reconnect links, 5–12
reconnect to instrument, 2–13
registration card, viii
required equipment
 for GPIB connection, 5–10
 for RS-232 connection, 5–10
requirements, system, 1–3
restore data sheet, 5–12
restore waveform to instrument, 
5–9
restore workbook, 5–13
RS-232
adding instrument to IMS, 2–5
baud rate, 2–5
cable examples by product fami-
ly, 8–6
cable issues, 8–5
data bits, 2–6
flow control, 2–6
general hints, 8–4
parity, 2–6
stop bits, 2–6
terminator, 2–6
timeout rate, 2–6
S

save and print repetitive data, 5–15
save data sheet, 5–11
save scalar workbook, 5–12
scalar viewer sheet
  I/O operations, 4–23
  overview, 4–23
  property sheet, 4–24
  supported applications, 4–24
set up data source, 5–7
setting properties, 4–3
software license, viii
stop bits, 2–6
stripchart sheet
  copying vs. linking, 4–16
  I/O operations, 4–15
  overview, 4–15
  property sheet, 4–16
  start recording, 4–16
  stop recording, 4–16
  using cursors, 4–16
supported oscilloscopes, 1–4
switching an instrument online or
  offline, 2–12
system requirements, 1–3

T

TDS 200 series, 1–4
  RS-232 connection, 8–1
TDS 300 series, 1–4
  RS-232 connection, 8–1
TDS 3000 series, 1–4
  RS-232 connection, 8–1
TDS 400 series, 1–4
  RS-232 connection, 8–3
TDS 500 series, 1–4
  RS-232 connection, 8–3
  TDS 600 series, 1–4
    RS-232 connection, 8–3
TDS 700 series, 1–4
    RS-232 connection, 8–3
TDS 800 series, 1–4
    RS-232 connection, 8–3
TekVisa, 1–12
  installation, 1–7, 1–10
  terminator, 2–6
THS 700 series, 1–4
  RS-232 connection, 8–1
timeout rate, 2–6
toolbar, 3–4
troubleshooting
  RS-232 cable issues, 8–5
  RS-232 communications port test,
    6–5
  RS-232 hints, 8–4
  TX-DMM serial cable test, 6–6
  WSTRM cable functional check,
    6–3
  TX-DMM series, 1–4

U

user proxy table utility
control settings in the main
  screen, 7–6
fields in user proxy registry
  settings, 7–9
file menu, 7–4
help menu, 7–6
initialization commands, 7–2
initialization screen, 7–8
main screen overview, 7–3
proxy file overview, 7–1
record menu, 7–5
records, 7–1
registry screen, 7–9
toolbar, 7–6
Using data sheets, 3–5

V
view menu, 3–3
correlation menu commands, 4–7
overview, 4–7
status bar, 4–5
terminology, 4–8
toolbar, 6–13
VISA, 1–12

W
waveform measurement sheet
I/O operations, 4–22
overview, 4–21
property sheet, 4–22
supported applications, 4–22
using gates, 4–22
waveform plot style, 5–6
waveform tabular sheet
I/O operations, 4–12
overview, 4–11
property sheet, 4–12
using gates, 4–12

window menu, 3–4
WSTR31 file conversion, 5–14
WSTRM, connecting meter to PC, 6–2

X
XY sheet
I/O operations, 4–8
overview, 4–8
property sheet, 4–10
using cursors, 4–10
zooming, 4–9

Y
YT sheet
overview, 4–5
print banner, 4–7
property sheet, 4–7
using cursors, 4–7
using gates, 4–7
waveform operations, 4–6
zooming, 4–6

Z
zoom, 5–3